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Prior to use, read this operating manual carefully and familiarize yourself with the product. The 
installation and start-up should not be performed without reading and understanding this 
document. Keep this manual readily available so that you can reference it as needed. 
 

1.1  What Is the Purpose of this Operating Manual? 
This manual serves as an aid for the installation and operation of the product and supports the 
technical staff with all operating and maintenance tasks to be performed. Furthermore, this 
manual is aimed at preventing dangers to life and health of the user and third parties. 
 

1.2  Who Is this Operating Manual Targeted to? 
The operating manual provides a code of conduct for personnel tasked with the set-up, 
operation, maintenance, and repair of gas engines. A certain level of technical knowledge with 
respect to the operation of gas engines and basic knowledge of electronic ignition systems are 
necessary. Persons who are merely authorized to operate the gas engine shall be trained by the 
operating company and shall be expressly instructed concerning potential hazards. 
 

1.3  What Symbols Are Used in the Operating Manual? 
The following symbols are used in this manual and shall be observed: 

 

Example 

This symbol indicates examples that illustrate the necessary steps and 
techniques for you. Furthermore, the examples provide you with 
supplemental information to increase your knowledge. 

   

 

Notice 

This symbol indicates important information for the operator. Observe 
these instructions. Additionally, this symbol is used for overviews that 
provide you with a summary of the required work steps. 

   

 

Warning 

This symbol indicates warnings of potential risks of damage or danger to 
health. Read these warning notices carefully and take the stated safety 
precautions. 

   

1 GENERAL INFORMATION
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Danger 

This symbol warns of danger to life, especially due to high voltage. Read 
these warning notices carefully and take the stated safety precautions. 

  
 

1.4  What Abbreviations / Acronyms Are Used in the Operating Manual? 
In the manual or the user interface, the following abbreviations / acronyms are used. 

Abb. Term Description Explanation 

ADV Advance advanced with respect 
to the top dead center 

Indicates the direction for the 
timing 

ASC Automatic Spark 
Control 

Automatic spark 
duration control function 

ASO Auxiliary  
Synchroniz- 
ation Output 

Auxiliary 
synchronization  
output 

Output for synchronizing the 
MIC850 and other controllers 

ATDC After top dead center   

BTDC Before top dead center   

CAN  
bus 

Controller Area 
Network Bus 

Bus for control 
devices / networks 

Asynchronous serial 
connection system for 
networking control devices 

CE Conformité 
Européenne 

Documents 
compliance with EU 
directives 

Mark based on EU legislation 
for certain products in 
conjunction with product safety

CPU Central Processing 
Unit 

Central processing 
unit 

  

°crank- 
shaft 

Crankshaft angle in 
degrees 

Unit for the rotation angle of 
the crankshaft 

CSA Canadian Standards 
Association 

Organization that defines 
standards, inspects products 
for safety compliance, and 
issues pertinent certifications. 

DC Direct Current Direct current   

DetCon Detonation Control 
System 

Detonation
control system 

Serves to prevent major engine 
damage that can be caused by 
knocking combustion. 
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Abb. Term Description Explanation 

EMI Electromagnetic 
interference 

Electromagnetic
 interference  

EMC Electromagnetic 
Compatibility 

Compatibility of electrical or 
electronic equipment items 
with their surroundings. 

GPO General Purpose 
Output 

General purpose
 output 

HMI Human-Machine 
Interface 

Human-
machine  
interface 

Interface between human and 
machine or computer 

HV High Voltage High voltage

LED Light Emitting Diode Light emitting diode Light emitting electronic semi-
conductor 

MIC MOTORTECH Ignition 
Controller 

MOTORTECH 
ignition controller 

POT Potentiometer Continuously adjustable 
potential divider 

PWR Power Output / current

RET Retard retarded with respect 
to the top dead center 

Indicates the direction for the 
timing 

SCR Silicon Controlled 
Rectifier 

A special type of thyristor

SD  
card 

Secure digital 
card 

secure digital data 
storage medium 

Digital storage medium

TDC Top dead center

USB Universal serial bus Serial wiring system to connect 
a computer to external 
equipment 
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2.1  General Safety Instructions 
The following safety instructions must be observed in the environment in which the equipment is 
operated. 

  

 

High voltage! Danger to life! 

While the engine is running, especially the area around the ignition system 
holds the risk of danger due to high voltage. Therefore, the following parts 
must not be touched or removed: 

– ignition coils and boots 

– wires of the high voltage circuit 

– connectors of the input / output wiring 

– pickups and their wiring 

  
MOTORTECH equipment is manufactured as state of the art and therefore safe and reliable to 
operate. Nonetheless, the equipment may cause danger or damage if the following instructions 
are disregarded: 

– The gas engine must be operated by trained and authorized personnel, only. 

– Operate the equipment only within the parameters specified in the technical data. 

– Use the equipment correctly and for its intended use only. 

– Never apply force. 

– For all work such as installation, conversion, adaptation, maintenance, and repair, all 
equipment must be disconnected from the mains and secured against unintentional 
reactivation. 

– Perform only such maintenance and repair work as is described in this operating manual, 
and follow the instructions described while working. For maintenance of the equipment, 
only use spare parts supplied by MOTORTECH. Further work must only be performed by 
personnel authorized by MOTORTECH. Non-compliance with the instructions will void any 
warranties for the proper function of the equipment as well as the responsibility for the 
validity of the certifications. 

– Safety devices must not be dismounted or disabled. 

– Avoid all activities that can impair the function of the equipment. 

– Operate the equipment only while it is in proper condition. 

– Investigate all changes detected while operating the gas engine or ignition system. 

– Ensure compliance with all directives and regulations applicable to the operation of your 
system, including such not expressly stated herein. 

– Always ensure adequate ventilation of the engine compartment. 

– Ensure a safe position at the gas engine. 
 

2 SAFETY INSTRUCTIONS
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2.2  Electrostatic Discharge Hazards 
Electronic equipment is sensitive to static electricity. To protect these components from damage 
caused by static electricity, special precautions must be taken to minimize or prevent 
electrostatic discharge. 

Observe these safety precautions while you work with the equipment or in its vicinity. 

– Before performing maintenance or repair work, ensure that the static electricity inherent to 
your body is discharged. 

– Do not wear clothing made from synthetic materials to prevent static electricity from 
building up. Your clothing should therefore be made of cotton or cotton mix materials. 

– Keep plastics such as vinyl and styrofoam materials as far away from the control system, the 
modules, and the work environment as possible. 

– Do not remove the circuit boards from the housing of the device. 
 

2.3  Special Safety Instructions for the Controller 
  

 

Explosion hazard! 

While the system is live, do not remove any connectors unless the absence 
of potentially explosive atmospheres around the system is ensured. 

   

 

Explosion hazard! 

The replacement of parts or assemblies can impair compliance with CSA 
Class I, Division 2 (Group C, D). 

   

 

Explosion hazard! 

Never remove the equipment while it is connected to a power source unless 
the absence of potentially explosive atmospheres around the system is 
ensured. 

   

 

Explosion hazard! 

Do not remove or replace the fuse while the equipment is live. 
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Risk of burning! 

The surfaces of the system may heat up to high temperatures. 

   

 

Operational safety! 

All screws of the connectors must be adequately tightened. 

   

 

Danger to persons with pacemakers! 

The limits for effects on pacemakers can be exceeded by electromagnetic 
pulses in the cables connected to the ignition system. Persons with 
pacemakers must therefore not be present in the vicinity of the ignition 
system being operated. Mark the operating location of the ignition system 
with the corresponding standardized warning symbol. 

  
 

2.4  Proper Disposal 
After the expiration of its service life, MOTORTECH equipment can be disposed of with other 
commercial waste, or it may be returned to MOTORTECH. We will then ensure its environmentally 
friendly disposal. 
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3.1  Function Description 
The devices of the MIC850 series are microprocessor controlled high-voltage capacitor 
discharge ignition systems that comprise one 32 bit main processor (CPU) and up to two output 
boards. 

Please note that the manufacturer is not required to implement configurations of the ignition 
controller for specific engines, and that devices may be delivered without pertinent 
configuration. 

The ignition controllers of the MIC850 series use information supplied by the pickups to 
precisely determine the correct timing for the respective outputs. The timing is influenced by 
various inputs made either automatically or manually. This can be implemented with manual 
potentiometers, the input signals (4-20 mA or 0-5 V), a speed characteristic, or with a serial 
interface (USB, CAN bus). 

During operation, the ignition controllers continuously monitor the system status of all installed 
pickups and the correct operation of the primary ignition circuit by checking the information 
received. 

Depending on the severity of an error that is detected, the device will shut down immediately or 
warn the operator. A corresponding message can be viewed on a connected PC or the optionally 
installed front face display. 

To protect the engine, the ignition controllers additionally have an adjustable overspeed shut-
off. 
 

3.2  Applications 
The ignition controllers of the MIC850 series are designed for specific 2- or 4-stroke gas 
engines. 1 to max. 24 ignition outputs are available for individual and multiple ignition 
applications. 

The ignition controllers supply the energy required for the corresponding ignition coils of the 
gas engines and can supply signals for peripheral equipment. Any use other than the one 
described in the operating manual shall be considered improper use and will result in the 
voiding of all warranties. 
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4.1  Technical Data 

4.1.1 Certifications 
The ignition controllers of the MIC850 series are certified as per the following 
directives/regulations: 

CSA 
– Class I; Division 2; Group C, D; T4 

– CSA Std C22.2 No. 0 -M91 (R 2006), 

– CSA Std C22.2 No. 142 -M91 (R 2004), 

– CSA Std C22.2 No. 213 -M91 (R 2004), 

– ANSI/ISA 12.12.01, Ed. 1 (2007), 

– UL Std No. 916, Ed. 3 (1998) 

CE 
– EMC directives 

– Limits as per DIN EN 55011 (2007:11) 

– Interference emission for industrial environments as per DIN EN 61000-6-4 (2007:09) 

– Interference emission for industrial environments as per DIN EN 61000-6-2 (2006:03) 
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 DECLARATION OF CONFORMITY 

The company: MOTORTECH GmbH
Hogrevestrasse 21-23 
29223 Celle 

declares that the products: Ignition Controller

purpose: use with gas otto engines

is in compliance with the specifications of the following EU directives:

 EMC directive 2004/108/EC

Low-voltage directive 2006/95/EG 
Application on gas engines 

taking into account the following standards:

 DIN EN 55011-2007:11
DIN EN 61000-6-2-2006:03 
DIN EN 61000-6-4-2007:09 

The identification code of the product is: P/N 66.00.85x

 

This declaration is delivered by:

Name: Florian Virchow 
 

Position within the company: Managing 
director 

  

  

  

Celle, dated 07/01/2009 

Place, date 

 
Legally binding signature 
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4.1.2 Mechanical Data 
The MIC850 has the following mechanical characteristics. 

Characteristic Value 

Dimensions 343 x 279 x 163 mm (13.5 x 10.98 x 6.42 ")
(length x width x height) 

Weight 10,8 kg (23.8 lbs)

Shape of device See chapter Overview Drawings on page 27. 

Mechanical environmental 
conditions 

The housing is resistant to general atmospheric 
contaminations. 

Resistant to gas engine lubricants. 

Protection class: 1 
Degree of protection: IP65 

Climatic environmental 
conditions 

with HMI:
 -20° C to +60° C max.(-4° F to +140° F) 
without HMI:  
-40° C to +70° C max. (-40° F to +158° F) 

85% relative humidity, max. without condensation 
up to 2000 m (6561.68') above sea level 

 
 

4.1.3 Warning Notices on the Controller 

Warning notice on front cover - Outside 
WARNING! Read and understand the installation and operation manuals prior to installing or 
making any adjustments. 

Warning notice on front cover - Inside 
WARNING – EXPLOSION HAZARD – Do not disconnect while circuit is live unless area is known to 
be non-hazardous. For wiring details please refer to operation manual. 

Warning notice on housing - side 
CAUTION – Do not pressure wash this ignition module. Damage to electronic components may 
result. Do not disconnect while circuit is live. 
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4.1.4 Product Identification - Labeling on the Device 
Plate on cover panel, inside: 

 

Meaning 

Part number of ignition controller 

Arrangement No. of ignition controller 

Serial number of ignition controller 

Serial number of main processor circuit board (CPU) 

Serial number of output board A

Serial number of output board B

 
 

4.1.5 Electrical Data 
The MIC850 has the following electrical characteristics. 

Characteristic Value 

Power consumption max. 144 W at 24 V

Power  
supply 

18 to 30 V DC

Required current Rest current with display module 0.45 A, current max. 8 A. An 
estimation of the power requirements can be found after this 
table. 

Internal fuse 8 ampere, time-lag

Number of outputs 12 or 24 outputs, depending on the model, up to two output 
boards are connected. 

Ignition frequency max. 250 Hz

Ignition Angle The size of the ignition angle depends on the max. overspeed. 
The smallest ignition angle per output board can be calculated 
using the following formula: 
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Characteristic Value 

Output  
voltage and energy 

 
The output voltage can be set between 20% and 100%. With a 
supply voltage below 18V, the MIC850 runs in the Limp mode and 
automatically limits the energy to 80%. 

Output connector Military connector

– one output board: Input connector, 14-pole, socket 

– two output boards: Input connector, 35-pole, socket 

Additional configurations are possible upon request. 

  

Estimation of the current requirements 
These current values are based on a nominal speed of 2000 RPM and 100% energy at 24 VDC 
input voltage. 

Outputs Voltage Required current Voltage Required current 

8 24 Volt 2.2 A 18 Volt 3.0 A

12 24 Volt 2.9 A 18 Volt 3.9 A

24 24 Volt 5.1 A 18 Volt 6.8 A
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Electrical data for inputs and outputs 
The inputs and outputs of the ignition controller have the following electrical data:  

Inputs and outputs Values 

4-20 mA input working resistance 10 Ω to ground, damping 1 μF

Auxiliary power 18 to 30 V depending on the supply voltage of 
the MIC850, 0.3 amp 

0-5 V input working resistance 10 kΩ to ground, damping 1 μF

Auxiliary power 5 V, 0.3 amp 

Digital input (Start/Stop) Wiring

Impedance: 10 kΩ 
ignition stop: 2.8-30 V 
ignition release: 0-0.8 V 

Digital input (schedule A/B) Wiring

Impedance: 10 kΩ 
schedule A: 2.8-30 V 
schedule B: 0-0.8 V 

Go/NoGo and GPO outputs 3 GPO (general purpose outputs) and 1 Go/NoGo output

Implementation as optical MosFET 

Voltage applied: 7 to 60 V DC max. 

Peak/steady current: 0.45 A DC max. 

Output: 500 mW max. 

Internal resistance: 0.55 Ω typically / 2.0 Ω max. 

Activation delay: 5 ms / 100 mA load max. 

Deactivation delay: 1 ms / 100 mA load max. 

If a short is found at the output, a safety circuit is activated, 
which maintains the output in pulsed operation until the 
short is eliminated. 

Signal LED An LED for indicating the power supply, 10 others are used as 
status indicators. 

ASO outputs  
(1 + 2) 

TTL level (5 V)
current: max. 2 mA 
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Inputs and outputs Values 

Pickup  
input 

Impedance: 10 kΩ

Power supply for inductive pickups is dependent on the input 
voltage, e.g. 24 V for an input voltage of 24 V. 

Max. frequency for the pickups: 8 kHz 

The formula for determining the frequency of the pickups can 
be found in the note following this table. 

Ignition coil outputs Output voltage: 390 V max. 

Output energy: 180 mJ max. 

Internal resistance: 45 mΩ min. 

1:1 measuring output The 1:1 measuring output is connected to the storage 
capacitor of the ignition power supply via a series resistor 
(100 Ω). If this output is loaded, the following functions are 
no longer ensured: 

– Misfire Detection 

– ASC analysis 

– SCR / HV error detection 

– Ignition Energy 

1:10 measuring output Storage capacitor voltage with 1:10 divider. Can be loaded 
with max. 10 MΩ. 

  

 

Frequency of the pickups 

The frequency of the pickups is calculated as per the following formula. 
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4.1.6 Interfaces 

USB 
– Compatible with USB 1.1 and USB 2.0 

– The Connector B version is suitable only for temporary data exchange and not for permanent 
connections. 

CAN bus 2.0B interface 
– As per ISO 11898 standard, max. 1 MBit/s 

– Protected against transients (automobile classification) 

– 110 participants max. 

SD card slot 
– for software updates 

The following SD cards are supported: 
– SD cards with 1.0 (up to 1 GB) and 1.1 (up to 2 GB) specifications 

– FAT16 or FAT32 formatting 
 

4.1.7 HMI Display 

Graphics display 
– 240 x 128 pixels 

– With LED backlighting 

– Eight keys for input 
 

4.1.8 Requirements for External Equipment 
External equipment shall fulfill the input and output specifications of the MIC850. 
 



 
 
 

Rev. 07/2011 27 

4.1.9 Overview Drawings 
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Labeling Function 

USB USB connection for connecting to the PC 

JTAG JTAG interface (to be used by factory only) 

Potentiometer 
A/B 

Potentiometer for manually adjusting the timing (adjustment has an 
effect only if the potentiometers were activated in the MICT). 

Display port Connection to HMI (optional)

PB 1 Pushbutton 1; briefly press it to acknowledge warnings, press longer to 
acknowledge errors, as well. 

PB 2 Pushbutton 2; press and hold to restart the device.

Power (LED) LED is on while the device is connected to the supply voltage.
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Labeling Function 

Status LED flashes when the device is active. 

Firing LED flashes when the ignition is active. 

PU A to C Flashing LEDs indicate activity of the pickups.

GPO 1 to 3 LED is on when the corresponding GPO is activated.

Warning LED is on when a warning has occurred. 

Error LED is on when an error has occurred. 

Fuse Fuse (see Electrical Data on page 22) 

ASO Connection for the auxiliary synchronization outputs (see Output Wiring 
- ASO on page 38) 

Output Connection for the Go/NoGo and GPO 1 to 3 outputs

CAN CAN interface for connecting external equipment (see Output Wiring -
CAN Bus - Interface on page 39) 

Power 
(connection) 

Connection for the supply voltage (see Input Wiring - Power Supply on 
page 32)  

Input Connection for timing & safety devices (see Input Wiring - Timing and 
Safety Devices on page 35)  

Pickup Connection for the pickups (see Input Wiring - Pickups on page 33)

SD card Slot for SD card for firmware updates (see  Firmware Update on page 
152) 
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5.1  Unpacking 
Unpack the equipment, taking care not to damage it, and ensure that the operating manual is 
always stored with the ignition controller and is easily accessible. Check the contents for 
completeness and verify that the controller type meets your application requirements. 

Scope of supply 
The supply scope of the MIC850 ignition controllers consists in the following components: 

– Ignition controller of the MIC850 series 

– Installation set incl. four vibration dampers 

– Ground strap 

– CD-ROM with software for configuring the ignition controller 

– USB interface cable for connecting the ignition controller to a PC/laptop 

– Operating manual 
 

5.2  Defining Installation Locations, Installing Sensors, Setting Timing 
Correction Range and Trigger Disc 

The positions of the pickups must be determined depending on engine type and application 
(individual ignition, multiple ignition). All angle reference information is based on: 

TDC #1 cylinder /compression cycle 

The installation location for the pickups must have adequate mechanical strength and must not 
exceed the specified temperature ranges. The pickups are designed for the corresponding use 
only, multiple use of the pickup signal is not permissible. Ensure good accessibility to facilitate 
the calibration of the sensor. Comply with the pertinent regulations for the wire routing. 

For the exact positioning of the individual pickups, refer to the examples given in the drawings 
(see section Input Wiring - Pickups on page 33). 
 

5 INSTALLATION INSTRUCTIONS
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5.3  Installation of the Ignition Controller 
The installation of the MIC850 ignition controller is implemented on a fixed bracket or a wall 
near the engine. Always use the included vibration dampers and the ground strap. The 
installation location of the controller must be selected so that the distance to the pickups 
installed on the engine ensures a reliable signal transmission to the ignition controller, and so 
that there is adequate space for maintenance and repair work. The mechanical specifications 
must always be complied with. The ground strap serves to ground the ignition controller and 
must be used accordingly. Ensure a flawless electrical connection for this purpose. 

Installation locations where strong vibrations or ambient temperatures of below -40 °C (-40 °F) 
or above 70 °C (158 °F) exist are not permissible and result in the warranty being voided. For 
devices with HMI, the same applies to ambient temperatures of below -20 °C (-4 °F) or above 
60 °C (140 °F). 

  

 

Risk of damage 

The controller must not be installed directly on or at the engine, as vibration 
and heat may cause damage to electronic components. 
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6.1  Input and Output Wiring on the Controller 

6.1.1 Input Wiring - Power Supply 

 

 

Variations 

1 Battery Generator Control Unit

 
2  Power Supply

 
3  Battery Charger
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6.1.2 Input Wiring - Pickups 

  

Camshaft

Crankshaft 
(Reset) 

Crankshaft
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Assignment of wire colors 
Camshaft 

PIN Labeling Wire color 

1 PU 1 black

2 PU 1 COM blue

3 Shield shield

4 PU PWR (+24 V DC) brown

  
Crankshaft (Reset) 

PIN Labeling Wire color 

5 PU 2 flywheel with PIN

white 

flywheel with hole

brown 

6 PU 2 COM flywheel with PIN

brown 

flywheel with hole

white 

7 Shield shield

  
Crankshaft  

PIN Labeling Wire color 

8 PU 3 white

9 PU 3 COM brown

10 Shield shield

  
In case of problems with the pickup signal refer also to the section Pickup Input Errors on 
page 159. 

  

 

Supply voltage for pickups 

The supply voltage supplied from the MIC850 to the pickups equals the 
general supply voltage (24 V DC). 
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Adjusting the pickup sensitivity 

Depending on the type of impulse source (interference), it may be necessary 
to increase the pickup sensitivity to ensure that the resultant signal 
strength is sufficient for reliable operation. You can make these 
adjustments in the MICT. Refer to the section Engine - Pickups on page 72. 

  
 

6.1.3 Input Wiring - Timing and Safety Devices 
    

  

Switch A/B 

open Schedule A

closed Schedule B

  

Switch Start/Stop 

open Ignition - OFF

closed Ignition - ON

 
* For details, see Subsequent Drawings 
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Two-wire transmitter 

 

Four-wire transmitter 
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6.1.4 Output Wiring – Go/NoGo and GPO 
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6.1.5 Output Wiring - ASO 
 
  DetCon Other equipment
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6.1.6 Output Wiring - CAN Bus - Interface 
  First device Second-to-last device

  

   Second device Last device

  

 

CAN Bus Wiring 

Follow the following instructions for the CAN bus wiring: 

– Max. 110 devices can be connected to a CAN bus. 

– The max. cable length is 250 m (820 ft). 

– Each bus end must be fitted with a terminating resistor with 120 Ω (as 
indicated in the drawing). 

  
 

6.2  Ignition Coil Wiring 
  

 

Default ignition coil wiring 

The default wiring specifies that the first cylinder in the ignition sequence is 
connected to the A1 output, the second to B1 (A2 for an output board), etc. If 
a different wiring was implemented, the MICT configuration must be 
adapted accordingly. Please note that the wiring cannot be checked by the 
software. 
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6.2.1 p/n 66.00.855-12(-D) – 14-Pole Connector, Socket (Standard Design) 

 

Pole Assignment 14-Pole Connector, Socket (View: Socket from Outside) 
  

Pole Pole assignment 

A Output A1 

B Output A2 

C Output A3 

D Output A4 

E Output A5 

F Output A6 

G Output A7 

H Output A8 

I Output A9 

J Output A10 

K Output A11 

L Output A12 

M Measuring output (1:1)

N Ground 

 
 



 
 
 

Rev. 07/2011 41 

6.2.2 p/n 66.00.855-24(-D) – 35-Pole Connector, Socket (Standard Design) 

 

Pole Assignment 35-Pole Connector, Socket (View: Socket from Outside) 
  

Pole Pole assignment Pole Pole assignment 

A Output A1 U Output B9

B Output B1 V Output A10

C Output A2 W Output B10

D Output B2 X Output A11

E Output A3 Y Output B11

F Output B3 Z Output A12

G Output A4 a Output B12

H Output B4 b Output not available

J Output A5 c Output not available

K Output B5 d Output not available

L Output A6 e Output not available

M Output B6 f Output not available

N Output A7 g Output not available

P Output B7 h Output not available

R Output A8 j Output not available

S Output B8 k Measuring output (1:1) A

T Output A9 l Measuring output (1:1) B

    m Ground
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6.2.3 p/n 66.00.850-24(-D) – 19-Pole Connector, Socket (Special Design) 

 

Pole Assignment 19-Pole Connector, Socket (View: Socket from Outside) 
  

Pole Pole assignment 

A Output A1 

B Output B1 

C Output A2 

D Output B2 

E Output A3 

F Output B3 

G Output A4 

H Measuring output (1:1) A

J Ground 

K Output B4 

L Output A5 

M Output B5 

N Output A6 

P Output B6 

R Output A7 

S Output B7 

T Output A8 

U Output B8 

V Measuring output (1:1) B
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6.2.4 p/n 66.00.851-24(-D) – 17-/14-Pole Connector, Socket (Special Design) 

 

Pole Assignments (View: Socket from the Outside) 
  

Pole Pole assignment (17-pole): Pole Pole assignment (14-pole): 

A Output A1 A Output B1

B Output A2 B Output B2

C Output A3 C Output B3

D Output A4 D Output B4

E Output A5 E Output B5

F Output A6 F Output B6

G Output A7 G Output B7

H Output A8 H Output B8

J Output A9 I Output B9

K Output A10 J Output B10

L Output A11 K Output B11

M Measuring output (1:1) A L Output B12

N Ground M Measuring output (1:1) B

P Output A12 N Ground

R Output not available   

S Output not available   

T Output not available   
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Wiring diagram - example: 16 cylinders 
 

 
*IFO: In Firing Order 

  

  

  

17-pole 
connector 

uneven 
cylinders 

  

  

  

14-pole 
connector 

even 
cylinders 
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The ignition controllers of the MIC850 series include freely configurable safety and auxiliary 
functions that, amongst others, can shut down the engine in case of fault. 

  

 

Angle indications in the operating manual 

All angles in this operating manual are given in °crankshaft. Exceptions are 
clearly identified. 

  
 

7.1  Check of Pickup Signals 
The MIC850 monitors the pickup signals. Potential errors are displayed in the MICT and HMI. For 
further information on errors, please refer to the overview in section Message and Error 
Overview on page 160. 
 

7.2  Go/NoGo 
The MosFET output (Go/NoGo) is a potential-free output that is closed during firing and opens 
when the ignition switches off. The max. switching current is 500 mA.  The output can drive an 
external relay that e.g. opens a gas valve. 

The following errors can cause the ignition outputs to shut down: 

– Overspeed 

– Pickup error 

– SCR malfunction / Error HV power supply 

– Overload / temperature shut-down 

– Alarms (see MICT) 

– Insufficient supply voltage (Low Power) 
 

7.3  Timing Correction 
The ignition controller has several functions for the timing correction. 

  

 

Influencing the ignition timing 

Please be aware that the actual timing of the engine can also be influenced 
by external signals (e.g. 0-5 V, 4-20 mA). 

   

7 FUNCTIONS 
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Operational Safety 

The MIC850 ignition controller must first be configured for the engine used 
before you can start the engine. 

An incorrect configuration can result in damage to the engine. 

  
The figure below gives you an overview of the different functions of the timing correction, which 
will be explained in more detail in the subsequent sections. 

 
 

7.3.1 Manual Timing Correction 
The ignition controllers of the MIC850 series include two permanently installed overwind-
protected potentiometers for manually correcting the timing point. The max. range is defined 
with the corresponding limits that are set by the user. If schedule B was activated in the 
configuration, and input Schedule A/B is closed, the ignition controller will reference the 
configured values of schedule B. 
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7.3.2 Analog Inputs – 4-20 mA / 0-5 V 
The timing point control can be adjusted with a linear 4-20 mA signal. This signal can be 
supplied e.g. by a potentiometer, a pressure sensor for charging pressure, or a detonation 
controller. 

With the analog process signal (4-20 mA current loop signal) at the 4-20 mA input, the timing 
point can be offset in the advanced or retarded direction within a defined range. 

At the 4-20 mA-PWR (+24 V DC) voltage output, the input voltage is supplied as an auxiliary 
voltage that can be used for supplying power to external sensors. 

Similarly or additionally, the timing can also be influenced by a 0-5 V signal at the corresponding 
0-5 V input. 

You can configure the analog inputs with the MICT. Refer to the section Timing - Schedule A/B on 
page 76. 

  

 

Sample configurations 

Characteristic 4-20 mA / 0-5 V – Timing correction toward retarded. 

 
Characteristic 4-20 mA / 0-5 V – Timing correction toward advanced. 
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Error setup 

The user must enter a pre-set 4-20 mA error setting (default), which ensures 
the safe and reliable operation if the input signal fails. The 0-5 V input does 
not have an error setting (default). In case a wire ruptures, the value set for 
0 V is used. If voltages above 5 V occur, the value defined for 5 V is used. 

  
 

7.3.3 Cylinder-to-Cylinder Alignment 
The cylinder-to-cylinder alignment enables the user to change the timing for individual cylinders 
to optimize their combustion. 

You can enter the settings for the cylinder-to-cylinder alignment with the MICT. Please refer to 
the section Cylinder Individual Offsets on page 107. 

  

 

Use of measuring unit 

Use this setup option only if no suitable measuring unit is available for 
determining the optimum timing point, so that the result of a change can be 
assessed immediately. 

  
 

7.3.4 Speed Curve 
To e.g. optimize the ignition during the start phase of the engine, a speed curve can be defined 
for the MIC850 ignition controllers. To create this curve, up to eight adjustable speed points are 
available. 

You can configure the speed curve with the MICT. Refer to the section Timing - Schedule A/B on 
page 76. 
 

7.3.5 Timing Correction 
The timing correction can be implemented in different ways: 

– CANopen 
With CANopen, the cylinder individual timing points, delimited by the timing point limits of 
the current parameter settings, can be adjusted in 0.1° increments by max. +/- 
12.7°crankshaft. 

– MICT via USB 
Please refer to the section Runtime Adjustments - Timing on page 105. 

– HMI 
Refer to the section Setting the Timing on page 129. 
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7.4  Ignition Angle 
The min. distance between two ignition angles depends on the overspeed. The smallest ignition 
spacing per output board can be calculated using the following formula: 

 
 

7.5  Misfire Detection 
The MIC850 ignition controllers include a primary winding misfire detection (open circuit or 
short), which measures all misfires per cycle and compares the result to a misfire rate selected 
and set by the user. If this rate is exceeded, the ignition will be automatically deactivated. The 
misfire rate is determined individually for each output, based on 20 cycles. 

If a specific coil type was set on the MICT, secondary winding misfires (open circuit or short) are 
also recorded and incorporated in the misfire rate. 

For the max. misfire rate, you can define an Alarm in the MICT. Refer to the section Outputs - 
Alarms on page 78. 

  

 

Operational safety 

If no alarm was defined for the primary misfire detection, this can result in 
an unsafe or unreliable operational state when an open circuit occurs in the 
primary wiring. 

  
 

7.6  SCR Error Detection / HV Power Supply Error Monitoring 
On the output circuit boards of the MIC850 ignition controllers, thyristors (SCR: Silicon 
Controlled Rectifier) are used. If one of these thyristors is faulty, the respective cylinder output 
will fire permanently, which can result in damage to the engine. To avoid engine damage, the 
MIC850 ignition controllers are therefore fitted with an integrated monitoring feature, which 
shuts down the ignition if a problem is detected. 
 

7.7  Schedules A/B 
The MIC850 ignition controllers offer two separate schedules for the parameterization of: 

– Timing point limits 

– Base timing 

– Potentiometer adjustments 

– Settings of the analog inputs 

– Speed Curve 



7 FUNCTIONS 
 
 

50 Rev. 07/2011 

By closing input Schedule A/B , the listed parameter settings for schedule B can be selected. A 
possible application for this is e.g. the operation with different gases. 

You can configure the schedules with the MICT. Refer to the section Engine - Parameters on 
page 66. 

  

 

Parameter settings (Schedule) 

The timing for the schedules can consist in: 

Base timing 

+ potentiometer 

+ (4-20 mA) 

+ (0-5 V) 

+ speed curve 

+ limits for timing 

   

 

Operational Safety 

If you use the schedules A and B, the advanced timing point should be 
linked to schedule B (switch closure). If a wire ruptures, the schedule A is 
automatically selected with the retarded (and thus safer) timing point. 

  
 

7.8  Alarms 
The MIC850 ignition controllers include 24 freely configurable alarms in total. These alarms can 
be freely allocated to the general purpose outputs (GPO) and set depending on the following 
functions: 

– Limit for misfire rate exceeded / not reached 

– Limit for speed exceeded / not reached 

– Limit for engine hours exceeded / not reached 

– Limit for energy level exceeded / not reached 

– Limit for spark plug hours exceeded / not reached 

– Warning active 

– Error active 

– Limit for temperature exceeded / not reached 

– Limit for supply voltage exceeded / not reached 
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– Limit for global timing exceeded / not reached 

– Set input voltage on 0-5 V input exceeded / not reached 

– Set input current on 4-20 mA input exceeded / not reached 

A hysteresis can be defined for some alarms. You can configure the alarms with the MICT. Refer 
to the section Outputs - Alarms on page 78. 
 

7.9  GPOs: General Purpose Outputs 
The function of each of the three general purpose outputs (GPOs) can be set as desired as 
normally closed or normally open. The GPOs can be used for the freely definable alarms. 

You can enter the settings for the alarms with the MICT. Refer to the section Outputs - GPOs 
(General Purpose Outputs) on page 80. 
 

7.10  ASO 1 / 2: Auxiliary Synchronization Outputs 
The ASO is an output of the MIC850 for synchronizing the MIC850 ignition controller and a 
connected control unit. The possible applications include detonation control, valve control, and 
fuel injection control. 

The ASO signal is Low-Active, i.e. the pulse width is defined as the time difference between the 
raising and falling edge (pulse width = traising - tfalling). The raising edge of the signal marks the 
configured engine rotation angle. With the variable pulse width, the values can be allocated to 
the engine rotation angle. A max. of 24 pulses can be configured for this purpose. 

The pulse width is known at the time of the active edge, as the falling edge of the signal 
precedes the raising edge by the value of the pulse width. The controller calculates the duration 
of the falling edge from high-level to low-level and then back to the starting value of the high-
level. 

You can configure the auxiliary synchronization outputs with the MICT. Please refer to the 
section Outputs - ASO 1 and 2 (Auxiliary Synchronization Outputs) on page 81. 
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Application of the ASO Signal 

The following example will illustrate the application of the ASO signal: 

– Four-stroke engine with 6 cylinders 

– Ignition angle 120° - 120° 

Synchronization between MIC850 and valve controller 

Cyl. Ignition angle in 
°crankshaft 

ASO signal in 
°crankshaft 

Pulse duration in 
μs 

1 0/720 718 160

2 120 118 80

3 240 238 80

4 360 358 80

5 480 478 80

6 600 598 80

 

Schematic representation 

 
* active edge 

The valve controller shall receive the active edge of the ASO signal before 
the top dead center of a cylinder. The first pulse duration shall be twice as 
long and thus mark the beginning of a cycle. The ASO signal generated by 
the MIC850 increases by 2° each time before the ignition signal from Low to 
High, as can be seen in the schematic drawing. This edge is analyzed by 
the valve controller as the active edge. 

The ASO signal drops in accordance with the configured pulse duration 
from High to Low before the active edge. The valve controller then has 
already measured the pulse duration of the active edge and can provide 
information on the allocation of the signal. In the example shown here, the 
first cylinder is marked with a pulse width of 160 μs versus 80 μs for other 
cylinders. If the valve controller measures a pulse width of 160 μs, the 
subsequent signal is therefore allocated to the first cylinder. The next 
signal then corresponds with the second cylinder in the ignition sequence, 
etc. 
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7.11  Ignition Energy 
You can configure the ignition energy with the MICT. Refer to the section Energy - Energy Level on 
page 82.  
 

7.11.1 Manual 
The MIC850 ignition controllers supply ignition coils and spark plugs with an energy level that 
can be manually adjusted. It is possible to increase the set energy level automatically during the 
start process. This increase improves the start-up behavior. 
 

7.11.2 Based on the Spark Plug Operating Hours 
Aside from the manual energy level setting, it is possible to control the energy based on the 
operating hours of the spark plugs. For this control system, a curve consisting of up to eight 
points can be set. 
 

7.11.3 Auto Spark Control (ASC) 
The ignition energy is set by the Auto Spark Control (ASC) in such a way that the spark duration 
set with the MICT is reached. The spark duration shall be kept constant throughout the life of the 
spark plug. An automatic increase in energy results in an increase in spark duration. A manual 
change of the spark duration while in operation is not possible. 

  

 

Operational Safety 

To use the ASC function of the MIC850, only ASC-capable MOTORTECH 
ignition coils may be used, which are marked with the ASC logo. 

  
 

7.12  Pickup Sensitivity 
To increase the signal interference distance, the sensitivity of the pickup signal inputs can be 
changed for suitable pickup signals. For this purpose, a pre-trigger voltage can be set below 
which signals are interpreted as interference and are therefore not analyzed. A pre-trigger 
voltage set to a high level will thus result in a low pickup sensitivity level. 

You can enter the settings for the pickup sensitivity with the MICT. Refer to the section Engine - 
Pickups on page 72. 
 

7.13  Cylinder Individual Multiple Ignition 
The MIC850 offers the option of a cylinder individual multiple ignition for very high ignition 
energy demand. In this case, all cylinders of the engine are supplied with ignition energy from 
the output board A, the MIC850 then offers the option of supplying each cylinder a second time 
with ignition energy from the output board B with a freely adjustable delay. This is only possible 
for engines up to 12 cylinder. 
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You can configure the multiple ignition with the MICT. Refer to the section Engine - Ignition 
Outputs on page 69. 
 

7.14  Access Control 
The MIC850 has four operating levels, three of which can be secured with different PINs. As a 
default setting, the access controls are not activated. If the access control for the MIC850 is 
activated, it is independent from the access levels that control authorizations within the MICT.  

  

 

Access control in the MICT and on the MIC850 

A user is logged in to the Advanced Service access level on the MICT. He 
changes a configuration and would like to download the change to the 
MIC850. Although he has the full authorization set in the MICT, he is 
prompted to log in with the PIN for the Level 3 (Master) on the MIC850.  

  
On the four operating levels of the MIC850, different functions are at your disposal. The figure 
below illustrates this: 

 
The following functions are available on the different levels: 

– Level 0 (read only) 
Enables read-only access for all users. 

– Level 1 (operator) 
The user can access and use the commands Alarms, Error commands, and Output status on 
this level. Additionally, all display settings can be changed. 
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– Level 2 (Service) 
Only the Service level has access to modifications of the runtime adjustment for the timing 
point, ignition energy and self test period and to the commands Set engine/ spark plug 
hours and Self test. 

– Level 3 (Master) 
On this level, the Master can, in addition to the other adjustments, reset the runtime 
adjustment and reset all PINs as well as activate/disable the access control. 

For information on the access levels in the MICT, please refer to the sections Access Levels in the 
MICT on page 57. 
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MICT is an abbreviation for MOTORTECH Ignition Configuration Tool. With the MICT, you can 
configure your ignition controller, and you can view and adjust the operating data of your 
engine. 
 

8.1  MICT System Requirements 
For the installation of the MICT, the following min. requirements must be fulfilled: 

– x86 compatible PC, min. performance category Intel Pentium 4 with 2 GHz 

– 128 MB free working memory 

– 80 MB free disc space 

– USB 1.1 - compatible Interface 

– Display with min. XGA resolution (1024 x 786 pixels) 

– Microsoft Windows 2000 / XP 
 

8.2  MICT Installation 
The software you need for installing the MICT is located on the CD-ROM included with the 
ignition controller. 

To install the MICT, proceed as follows:  

1. Start the installation. 

– CD-ROM as installation medium 
Insert the CD-ROM in the CD/DVD drive of your PC. If the Autostart function is activated 
for the drive, the installation will start automatically. If the function is disabled for the 
drive, the installation routine can be started with the file setup.exe from the CD-ROM 
directory. 

– Alternative 
Copy the installation routine setup.exe to your PC. The installation is started by 
executing the file. 

2. Run the installation. 
Follow the instructions of the installation routine.  Please note that the license agreement 
terms must be accepted before using the MICT. If the terms are not accepted, the installation 
cannot continue. 

3. Install the USB driver by executing the file CDM2.04.16.exe. 

▸ The MICT is now set up.  You can connect your PC to the ignition controller via the USB 
interface. 

 

8 SETTINGS VIA THE MICT
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8.3  Access Levels in the MICT 
After opening the MICT, select the access level for which you have clearance. The access level 
controls the options you have at your disposal in the MICT. The password required for access is 
sent to you together with the ignition controller. 

 
The following access levels are possible: 

– Read Only 
On this level, the user can open a configuration and transfer it to the controller. They can, 
however, not make changes to the configuration. The user has read-only access to all other 
settings. 

– Customer 
This level enables the configuration of the basic functions required for operation in addition 
to the read-only function. 

– Service 
This level contains all functions for a standard installation. 

– Advanced Service 
This level offers full access to all functions of the MICT and is enabled and accessible for 
specially trained personnel only. 

The following sections will describe the options at your disposal with the Advanced Service 
access level. If you have registered for a different level, you cannot execute all functions shown. 
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8.4  Configuration Page (Overview) 
The configuration pages are divided into the following sections: 

 
The functions in the menu, navigation bar, and the toolbar as well as the configuration section 
will be described in the following.  

The status bar provides you with the following information (from left to right): 

– Status display 
Indicates whether a connection is established with the controller. 

– Green: connection established 

– Red: the connection was interrupted and is being restored 

– Gray: the connection is not established and is not being restored 

– Identification of the interface that is being used for a connection with the controller. 

– Indication of the device ID 

– Indication of the access level of the user in the MICT 

– Indication of the operating level for the MIC850 if the access control feature was activated 
and the user has logged in with a PIN. 

– Indication of the MICT program version 
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8.5  Menubar and Toolbar 
The following functions are available to you via the symbols on the toolbar and the entries in the 
menu bar: 

Symbol Menu Function 

 

File -> New Creates a new configuration.

 

File -> Open Opens an existing configuration.

 

File -> Save / 
File -> Save As 

Saves the current configuration.

 File -> Close Closes the current configuration.

 File -> Open Trace Opens a trace of recorded runtime data (.trace 
file). Please refer to the section Runtime Data 
on page 87. 

 

File -> Change Access Level Changes the access level for accessing the 
configuration data and functions. 

 

File -> Print Prints the current configuration.

 

File -> Print To PDF File Prints the configuration to a PDF file.

 File -> Print Preview Opens a print preview of the configuration.

 File -> Quit Exits the MICT.

 

Device -> Connect Connects to the device.

 

Device -> Disconnect Cuts the connection to the device.

 

Device -> Download to device Downloads configuration data from the PC to 
the device. This function can only be executed 
while the ignition is not active. 

 

Device -> Upload from device Uploads configuration data from the device to 
the PC. 
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Symbol Menu Function 

 

Device -> Runtime data Opens the window Runtime Data. Please refer 
to the section Runtime Data on page 87. 

 

Device -> Log Opens the window Log (Advanced service
only). Please refer to the section Log on page 
103. 

 

Device -> Runtime adjustments Opens the window Runtime Adjustments
(Service and Advanced Service only). Please 
refer to the section Runtime Adjustments on 
page 104. 

 

Device -> Cylinder individual 
offsets 

Opens the window Cylinder Individual Offsets
(Advanced Service only). Please refer to the 
section Cylinder Individual Offsets on page 
107. 

 Device -> Set spark plug runhours Opens the window Set spark plug runhours.

 Device -> Set engine operating 
hours 

Opens the window Set engine operating hours.

 Device -> Send command -> Reset 
output status flag 

The status of the outputs of the ignition 
controller is reset. Misfires that occurred at 
the outputs are thus no longer displayed. 

 Device -> Send command -> Start 
self test 

The self test is started. The cylinders of the 
connected engine fire sequentially. Please 
refer to the section Running a Self Test on 
page 162. 

 Device -> Send command -> Stop 
self test 

The self test is ended.

 Device -> Send command -> 
Acknowledge operational errors 

All operating errors are acknowledged. This 
can only be implemented while the engine is 
standing still.  

 Device -> Access Control The setup for the access controls for the 
MIC850 are described in a separate section. 
Please read the section Access Control for the 
MIC850 on page 62. 

 Device -> Temperature Extremes Opens the window Temperature Extremes in 
which the minimum and maximum 
temperatures of the controller and output 
boards are displayed. 
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Symbol Menu Function 

 Device -> HMI Screenshot Opens a window in which you can create a 
screenshot of the current display (HMI). 

 Device -> Supply voltage snapshot Opens a diagram of the supply voltage trend 
during the last second. 

 Device -> Low power supply 
voltage trend 

Opens a diagram of the supply voltage trend 
during the last second before last shutdown or 
last low power error. 

 Settings-> Language Opens the window Language selection in 
which you can change the interface language 
of the MICT. 

 Settings -> Online update settings Opens the window Online update settings. 
Please refer to the section Online Update 
Settings on page 62. 

 Settings -> Temperature scale Opens the window Select Temperature Scale,
in which you can change the unit for the 
temperatures shown in the MICT. 

 Settings -> Display by cylinders The entries in the window Runtime Data –
Ignition are displayed by cylinders. To use this 
function it's necessary to assign the cylinders 
to the ignition outputs on the configuration 
page Engine – Ignition Outputs. 

 

Document -> Energy curve Opens the window Energy curve. Please refer 
to the section Energy Curve on page 108. 

 

Document -> Schedule curve Opens the window Schedule curve. Please 
refer to the section Schedule Curve on page 
109. 

 Help -> Help Opens the online help function.

 Help -> About MICT Opens detailed information on the MICT.
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8.6  Online Update Settings 
The MICT uses data from an engine database and a coil database for the configuration. Such 
data can be updated with automatic online updates. The settings for the update can be entered 
with the following menu entry: 

Settings -> Online update settings 

 
You have the following options: 

– Enable automatic database updates 
Activate and disable the online update with the check box. As the default setting, the online 
update is activated and is executed daily (if an Internet connection is established) at first 
start-up of the MICT. 

– Use a proxy to access the web 
With the check box, you can activate settings for Internet access via a proxy server, which 
you can then set up by entering http Proxy and Port. 

– Show Log 
With this button, you can open a window in which the online updates performed are logged. 

– Update Now 
With this button, you manually start an online update. 

 

8.7  Access Control for the MIC850 
If the access controls for the MIC850 were activated, access to the following areas is possible 
with a PIN only: 

– Runtime Adjustment (Reset, timing, ignition energy, Auto Spark Control (ASC), and self test 
period) 

– Commands (Alarms, error commands, set motor/spark plug operating hours, and self test). 

– Configuration (Transferring a configuration to the MIC850) 

The access control controls the access to the controller with both the HMI and the MICT. For 
explanations concerning access control to the MIC850 and the delimitation of the access levels 
in the MICT, refer to section Access Control on page 54. 

The access control functions can be accessed in the menu bar via: 

Device -> Access Control 
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8.7.1 Activating/Disabling the Access Control 
   

 

Enabling and disabling access controls 

As a default setting, the access control is not activated, and all PINs are set 
to 0000. Once the access control has been activated, and the PINs were 
changed, these PINs will continue to be used. To activate the access 
controls again, you will need the PIN for level 3 (Master). It is therefore 
recommended to reset all PINs before disabling. 

If that was not done, or a system must be unlocked for another reason, a 
request key can be issued in the MICT. Refer to the section Resetting all 
PINs on page 64. 

  
To activate or disable the access control, proceed as follows: 

1. Open the input dialog via Device-> Access control -> Activate or disable access control. 

2. Enter the PIN for the level Master (level 3). 

3. Accept the input with OK. 
 

8.7.2 Login/Logout 
If the access controls are activated, you are prompted to log in if you want to execute functions 
that are allocated to a specific operating level. In addition, you can log in specifically to an 
operating level via the menu bar. 

To log into a specific operating level, proceed as follows: 

1. Open the input dialog via Device -> Access control -> Login. 

2. First select the level you wish to log on to. 

3. Enter the PIN for the desired level. 

4. Accept the input with OK. 

▸ You are now logged into the corresponding level and can execute all functions that are 
allocated to this operating level without having to log in again. 

After completing the log-in, you can log out again as follows: 

Device -> Access control -> Logout 
 



8 SETTINGS VIA THE MICT 
 
 

64 Rev. 07/2011 

8.7.3 Changing the PIN 
To change the PIN for a specific operating level, proceed as follows: 

1. Open the input dialog via Device -> Access control -> Change PIN. 

2. First select the level for which you wish to change the PIN. 

3. Enter the current PIN for the desired level. 

4. Enter the new PIN in the two subsequent fields. 

5. Accept the input with OK. 

▸ The PIN for this operating level has now been changed. 
 

8.7.4 Resetting all PINs 
To reset all PINs, proceed as follows: 

1. Open the input dialog via Device -> Access control -> Reset all PINs. 

2. If you are not logged in to the level Master (level 3) yet, you will be prompted to log in with 
the pertinent PIN. 

3. Accept the input with OK. 

4. To reset all PINs, you will be prompted again to enter the PIN for the level Master (level 3). 

5. Accept the input with OK. 

▸ All PINs are now reset to the value 0000. 

To reset all PINs, you need the PIN for the level Master (level 3). To be able to unlock a system in 
case of emergency that was locked in this way, you have the following option: 

1. With the menu entry Device -> Access control -> Get reset all PINs request key, open the 
window with the same title. 

2. Send the request key with the serial number to your service contact partner at MOTORTECH. 
This key is valid only for the respective controller and only for a certain amount of time. 

▸ Your information will be verified, and you will receive an authorization key from your 
contact partner. 

3. With the menu entry Device -> Access control -> Set reset all PINs authorization key, open the 
window with the same title. 

4. Enter the authorization key received in the input field. 

5. Accept the input with OK. 

▸ If the input was correct, all PINs are reset to the default value 0000. 
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8.8  Selecting the Device Type 

 

Click on the symbol to start a new configuration, and select the corresponding 
device type from the list. The device type of your ignition controller corresponds 
with the first five digits of the arrangement number, which you can find on the 
plate on the inside of the housing cover.  

 
 

8.9  Opening an Existing Configuration File 

 

Click on the symbol to open an existing configuration file.

 
 

8.10  Configuration 
The window opens after you select the device type for a new configuration or an existing 
configuration or have uploaded one from the ignition controller. You can make changes to the 
configuration by selecting an entry from the navigation bar. The pertinent configuration data are 
then displayed in the configuration section and can be processed. The following sections will 
describe the settings and adjustments you can implement in the different areas. 
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8.10.1 Engine - Parameters 

 

Engine Selection 
The MICT holds an engine database with data from various manufacturers and model series. 
Select the desired engine manufacturer, series, and type by clicking on the corresponding fields. 
After making your selections, the right hand section Engine Information will display a summary 
of the stored engine data. 

If the pertinent engine is not available in the database, the settings can also be entered by 
selecting the corresponding sequence. For this purpose, click on the entry Sequence in the 
column Engine Manufacturer and select the firing stroke in the column Series, then the number 
of cylinders, and the ignition offset of the engine as needed. After making your selections, the 
right hand section Engine Information will display a summary of the parameters selected. 

The summarized data are transferred to the subsequent configuration page Ignition Outputs. 
The values displayed there can only be changed by users with authorization to access the 
Advanced Service level. 
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Engine Database 

MOTORTECH does not assume liability for the information in the engine 
database. Please contact MOTORTECH if discrepancies are found. 

  
Staff with the authorization for the Advanced Service level additionally has the option for 
entering the engine data manually, i.e., without selecting entries from the engine database. For 
this purpose, click on the New Engine Configuration button and select the engine type, number 
of cycles, and number of cylinders in the dialog box opening up. Additional information can be 
entered on the configuration page Ignition Outputs. 

 

Multiple Ignition 
If you check the box Multiple Ignition, the settings for multiple ignition can be entered. You can 
then configure a second output for each cylinder that fires with an offset. Refer to the pertinent 
section Engine - Ignition Outputs on page 69. 
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8.10.2 Engine - Cylinder Names 

 
To facilitate the assignment of the cylinders during the configuration of the ignition outputs, you 
can individually name each cylinder. At this you are supported by a schematic top view of the 
selected engine. Enter the following settings: 

– Bank Name  
Enter a name of the respective cylinder bank. 

– Cylinder Names 
Enter a name of the respective cylinder. If the checkbox Multiple ignition was enabled for the 
configuration, you have two input fields for each cylinder to name the two ignition coils per 
cylinder differently. 

–  
Define the order of the cylinders of the respective bank for the display of the runtime data. If 
you select the bottom arrow the order is equivalent to the order shown on the configuration 
page. If you select the upper arrow the order is inverted for the display. 

– Invert order of banks for display 
Enable the checkbox to invert the order of the banks in the display of the runtime data. 
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Display by Cylinders 

For the display by cylinders in the runtime data the following steps are 
necessary: 

1. Name the cylinders on the configuration page Engine – Cylinder Names.

2. On the same configuration page you can make additional display 
settings (e.g. invert the order of the cylinders for display), if desired. 

3. Assign the cylinders to the ignition outputs on the configuration page 
Engine – Ignition Outputs. 

4. Enable the function via the menu entry Settings -> Display by cylinders. 

5. Download the modified configuration to the device. 

▸ In the window Runtime Data – Ignition the values are now displayed 
in the order of the cylinders 

  
 

8.10.3 Engine - Ignition Outputs 
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Make adjustments to the following settings as needed: 

– No. of Outputs 
Select the number of outputs for the respective output board. 

– Column: Cylinder 
Select a cylinder. The displayed names are set on the configuration page Engine – Cylinder 
Names. 

– Column: Output 
Select the number of the respective output. 

– Column: Angle 
Enter the ignition angle for each output. 

Default application 
If you select from the engine database, the data stored for the selected configuration are 
displayed. These data can only be changed by personnel with access to the Advanced Service 
level. 

New Engine Configuration 
If you created a new engine configuration on the configuration page Engine – Parameters via the 
corresponding button, the number of outputs is first distributed based on the number of 
cylinders on the output board A and output board B. Selecting the number of outputs enables 
access to the fields for the configuration of the outputs. We recommend that you distribute the 
number of outputs evenly among the output boards and allocate the larger number to the A 
board if the number is uneven. 

By default, the ignition outputs are distributed so that cylinder 1 of the ignition sequence is 
always allocated to output board A with an ignition angle of 0°. The further distribution is 
implemented by alternating between output boards A and B. The ignition angle for each output 
results from the addition of the ignition spacing to the respective previous output. 

  

 

Display by Cylinders 

For the display by cylinders in the runtime data the following steps are 
necessary: 

1. Name the cylinders on the configuration page Engine – Cylinder Names.

2. On the same configuration page you can make additional display 
settings (e.g. invert the order of the cylinders for display), if desired. 

3. Assign the cylinders to the ignition outputs on the configuration page 
Engine – Ignition Outputs. 

4. Enable the function via the menu entry Settings -> Display by cylinders. 

5. Download the modified configuration to the device. 

▸ In the window Runtime Data – Ignition the values are now displayed 
in the order of the cylinders 
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Multiple Ignition 
The MIC850 can also be used to drive two ignition coils per cylinder (up to twelve cylinders 
possible). If this function is used, the number of outputs used on each board is the same. The 
first ignition impulse is set via the angle, and the second ignition impulse is set by a delay 
compared to the first impulse. 

The corresponding setup options will only be visible in the subsequent window and the function 
will only be usable if the box Multiple Ignition was checked. You can find the latter in the window 
that was opened via the configuration page Engine – Parameters and the button New Engine 
Configuration. 

 
Additionally, enter the following setting for multiple ignition: 

– Column: Delay [μs] 
Enter the delay for the second ignition impulse for each output. With the button  you can 
apply the setting in the adjacent field to all outputs. 
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Operational safety 

Never connect more than one output to each ignition coil, as the output 
boards can otherwise be damaged! 

  
The allocation of outputs on the output boards to contacts of the output connector of the device 
and the cylinders is determined by the wiring. The user must take the wiring into account during 
the configuration; it cannot be checked by the software. 

  

 

Interval between two ignitions 

The interval between two ignitions on an output board must be min. 2.8 ms. 
During the check, the configured overspeed is used in the calculation. 

  
 

8.10.4 Engine - Pickups 
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Supply voltage for pickups 

The supply voltage supplied from the MIC850 to the pickups equals the 
general supply voltage (24 V DC). 

  

Pickup Setup Information 
The settings made in the Pickup Setup section were summarized once again in the section 
Pickup Setup Information. 

Pickup Setup 
Enter the following settings in this section: 

– Predefined Setup 
Select the pickup configuration suitable for your application from the list. The 
configurations available for selection depend on the previously entered settings. 

– Index/Reset position 
Enter the distance between the first event after the set index/ reset marking and the top 
dead center. With the button Adjust, you can enter the measured ignition angle for a given 
nominal value. The system calculates the difference from these values, which is added to or 
subtracted from the index/reset position. 

– Pickup Sensitivity 
Open the pick list and select the desired sensitivity level for the pickup from the list offered. 
This setting overwrites the value of the pre-trigger voltage if the latter was defined in the 
user-defined pickup settings. 

– high 
The signal processing starts at low engine speeds. This setting can result in increased 
susceptibility to failure. 

– moderate 
Standard setting of the MICT. This is a trade-off between start-up speed and sensitivity. 

– low 
The signal processing does not start until high engine speeds are reached. This setting 
can result in reduced susceptibility to failure. 

– Cam/Trigger 
Enter the number of events. The input for Cam or Trigger is automatically selected by the 
MICT and is governed by the selection of the pre-defined pickup settings. 
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– Arbitrary Pickup Setup 
Staff authorized to access the Advanced Service level can, in addition to the standard 
settings access, use a manual setup option by clicking on the button Arbitrary Pickup Setup. 

 
– Type 

Select the type of events that will occur on the respective input for each pickup input. 
Type and number of events are defined by the discs or ring gears used. If you decide not 
to use a pickup input, select the entry not used from the list. You can set the following 
types: 
N 
disc, which causes a uniformly distributed number (N) of events (per rotation), e.g. a 
ring gear with 160 teeth (N=160). 
N+1 
Disc of type N with one additional event, e.g. a disc with 12 teeth and one additional 
tooth for the index signal (N=12). 
N-1 
Disc of type N where one event is missing, e.g. a ring gear with 160 teeth on which one 
tooth was removed (N=160). This missing event is used to determine the index signal. 
N Magnets, Individual Magnet (not currently implemented) 
You will always use these two types together for a disc with magnets with opposite 
polarity. A fixed number (N) of the magnets has the same polarity, and a single magnet 
has the opposite polarity. Thus, the disc supplies two signals that can be analyzed by a 
pickup. Such a disc can e.g. be structured as follows: 60 magnets (N=60) point to the 
pickup with their north pole, and one magnet points to it with its south pole. All magnets 
are arranged at equal distances on the disc.  
Individual Result 
Disc that supplies a single event, e.g. a disc with one tooth or one magnet. 

– Number of Events 
Enter the number of events that occur on the pickup if more than one event is expected. 
For the types N+1 and N-1, enter the value for N and not the total number of events. With 
the type N Magnets, the number of magnets with identical polarity must be entered.  
The number of events must lie between three and 500. Additionally, it must be ensured 
that the sum of the frequencies at the pickup input does not exceed the limit of 8 kHz at 
the pre-set overspeed. 
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– Speed 
Select whether the respective pickup will pick up the signal off the camshaft or the 
crankshaft. 

– Active/Passive 
Select the pickup to be used from the pre-defined pick list: 
passive 
passive pickup 
active (low) 
active pickup with High level as quiescent level 
active (high) 
active pickup with Low level as quiescent level. 

– Pre-Trigger Voltage 
Enter a value between 0.1 V and 4.5 V to set the pickup sensitivity level. Signals that fall 
short of the set voltage will not be analyzed. A low pre-set value therefore results in a 
high sensitivity level, a high value results in a low sensitivity level. 

  

 

Pickup Setup Information 

The respective latest setting in the area of the pre-defined or arbitrary 
pickup settings is transferred to and displayed under Pickup setup 
information. 

  

Speed settings 
Enter the following settings in this section: 

– Ignition Release 
Enter the release speed for the ignition at which the first ignition is to fire. The value shall 
not exceed 1/7 of the nominal speed. 

– Security Speed 
Enter the security speed (max. half the nominal speed). Below the value entered, the ignition 
can be switched on and off as desired. If the ignition is deactivated during operation if the 
set speed is exceeded, the ignition cannot be immediately reactivated. Only when the 
ignition no longer reads a speed, i.e., the engine has come to a standstill, can the ignition 
be reactivated. 

– Nominal Speed 
Enter the nominal speed at which your engine is to be operated. With engines that are to be 
operated with variable speeds, the max. speed of the operating range must be entered. 
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– Overspeed 
Enter the speed at which the ignition is to be shut off as overspeed protection. With engines 
that are to be operated with variable speeds, a speed above the operating range must be 
entered. The following input will not be accepted by the device: 

– Input higher than 6000 RPM  

– Input causing pickup frequencies above 8 kHz. 

– Input that causes the average ignition frequencies of each output board to exceed 
250 Hz. 

 

8.10.5 Timing - Schedule A/B 

 

Schedule A 
The MIC850 offers two parameter sets for implementing the necessary settings for the timing of 
the engine. The schedules A and B can be used for dual fuel operation, for example. The system 
switches between the schedules via the input Schedule A/B. If only one set is configured 
(schedule A is enabled by default), the switch is ignored. The configuration options for schedule 
B are identical to those for set A. The settings are enabled or disabled by checking/unchecking 
the box. 
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Limits 
Enter the limits of the timing point at which the ignition can fire. The timing points of the outputs 
will be limited to this range relative to the respective top dead center of the pertinent cylinder. 
The global timing can then not be shifted beyond this range by any adjustments. 

Base Timing 
Enter the timing specified by the engine manufacturer. This point must be within the limits 
entered and is a static portion of the global timing. 

Potentiometer Function 
The check box Potentiometer Function activates and disables the potentiometer function for 
manually adjusting the global timing by the respective stops of the potentiometer set in 
dependence on the rotation direction. If the potentiometer is disabled again afterwards, the 
system will no longer access the data during the subsequent data transfer to the controller and 
restart of the engine, and the controller will no longer use them to calculate the global timing. 

Analog Inputs 
By clicking on the inputs 4-20 mA and 0-5 V, they can be activated or disabled. If you have the 
choice, you should prefer the 4-20 mA input due to its lower sensitivity to faults. Enter the values 
by which the adjustment is to be implemented for the corresponding input current. For the 4-
20 mA input, an additional default value can be entered by which the value (e.g. wire rupture) is 
to be adjusted in case the 4 mA limit is not reached, or if the signal fails completely. 

Speed curve 
The speed curve can be activated and disabled by mouse click and offsets the timing in 
dependence on the speed. A max. of eight speed points are available. If you select a number of 
points from the list, the corresponding number of fields is activated for input. 

The first speed point is always set to 0 RPM. All other timing points are assigned with the value 
by which the signal is to be offset when the respective speed is reached. For the last speed 
point, the timing of the nominal speed should be entered. Please note that the speed points 
must always be entered in ascending order. 

  

 

Simulation function 

To verify the values entered, the simulation function can be started via the 
symbol Schedule Curve or with the menu Document -> Schedule Curve. 
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8.10.6 Outputs - Alarms 

 
The MIC850 ignition controllers include a total of 24 configurable alarms that can be freely 
allocated to the general purpose outputs. 

– Description 
You can enter any desired description for an alarm. The description is used for logging the 
alarms that have occurred in the alarm lists in the MICT and the HMI. 

– Function 
The alarms can be used depending on the following functions: 

– unused 

– Misfire rate above threshold / below threshold 

– Speed above threshold / below threshold 

– Engine operating hours above threshold / below threshold 

– Energy above threshold / below threshold 

– Spark plug operating hours above threshold / below threshold 

– Warning active 

– Error active 

– Temperature above threshold / below threshold 
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– 0-5 V input above threshold / below threshold 

– 4-20 mA above threshold / below threshold 

– Global timing above threshold / below threshold 

– Supply voltage above threshold / below threshold 

– Min. spark duration above threshold / below threshold 

– Threshold 
Input of desired threshold value. 

– Hysteresis 
Input of desired hysteresis value. 

– Delay 
Input of desired delay The threshold value defined in the alarm must have been exceeded or 
not reached for a longer period than the specified time for an alarm to be triggered. If a 
corresponding value occurs for a shorter period of time, no alarm is triggered. 

– Engine Shutdown 
If this checkbox is checked, the ignition is switched off as soon as the alarm is triggered. 

– Permanent - output activated until alarm is acknowledged 
If this box is checked, the output remains permanently active until the alarm is 
acknowledged. If the box is not checked, the output remains active only for as long as the 
alarm is active. 

– Log Events 
If this box is checked, the MICT and HMI will log in the alarm list when the alarm occurred or 
when it was acknowledged. 

– Outputs 
Selection of the general purpose output (GPO) that is activated when the alarm is triggered. 

  

 

Sample alarm definitions 

The following alarms are frequently used to support the safe and reliable 
operation of the engine. 

– Speed switch 
With the function speed > threshold, you can, for example, determine 
that an output is activated upon reaching a speed just below the 
overspeed, which takes over a controller function for the engine. 

– Misfire rate 
A high misfire rate indicates an unreliable or unsafe operating state. To 
make the ignition controller react to an excessive misfire rate, e.g. by 
shutting down the engine, define an alarm with the function misfire rate 
> threshold and check the box Engine Shutdown. 
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Alarm for energy > threshold 

Please note with alarms for the function energy > threshold that a higher 
energy level may have been defined for the start phase of the engine than 
for the regular operation.  

  
 

8.10.7 Outputs - GPOs (General Purpose Outputs) 

 
– General purpose outputs 1 - 3 

The MIC850 has three configurable general purpose outputs. It is possible to configure the 
outputs as Normally closed or Normally open. The allocation of the general purpose outputs 
to alarms is carried out on the configuration screen Outputs - Alarms on page 78. 
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8.10.8 Outputs - ASO 1 and 2 (Auxiliary Synchronization Outputs) 

 
With the two auxiliary synchronization outputs, freely definable impulses depending on the 
angle of the crankshaft can be generated. For each output, the user defines whether the angle 
will be absolute or based on the global timing. Each output can generate between 1 and 24 
impulses and only be assigned to one system at a time. One example of the application of the 
ASO outputs for a detonation controller can be found in section ASO 1 / 2: Auxiliary 
Synchronization Outputs on page 51. 

– No. of Points 
Select the number of impulses from the No. of Points list. Please note that the DetCon 
detonation controller devices require a single impulse with 200 μs synchronous with the 
first cylinder in the ignition sequence. You get this setting via the button Configure for 
DetCon2/20. 

– Angle Reference 
Select from the Angle Reference drop-down list whether the angle shall be based on the 
absolute angle of the crankshaft or the actual angle depending on the global timing. Then, 
enter the trigger angle for each impulse and the length of the impulse in μs. 
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Maximum impulse duration 

Please note that the duration of the impulse can be entered as max. 300 μs. 
Input of higher values will not be accepted by the system. 

  
 

8.10.9 Energy - Energy Level 

 

Coil Parameters 
Select the ignition coil type used for the engine from the list. The stored coil characteristic is 
used to determine the spark duration and the secondary voltage in the runtime data. If no coil 
type was selected, the Auto Spark Control (ASC) function cannot be used. In addition, secondary 
voltage and spark duration cannot be determined, and the secondary winding misfire detection 
cannot be implemented.  
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Operational Safety 

Only one ignition coil type must be installed on the engine.  Combining 
different types is not possible. 

  

Start Phase 
Until the selected speed is reached, the energy is defined independently from other settings. 
After reaching this speed, the ignition controller switches back to the other settings. A speed 
between 0 RPM (min.) and half the nominal speed (max.)can be entered as the limit value. The 
energy value entered may vary between 20% and 100%. 

Energy Mode 
Define by mouse click whether the ignition energy will be determined manually, dependent on 
the operating hours of the spark plugs, or via the Auto Spark Control (ASC) when the start phase 
is completed. 

Manual Energy 
If you select the manual energy setting, enter the ignition energy that is to be used after 
completing the start phase. 

Energy depending on Spark Plug Runtime 
With this setting, you define the energy curve in dependence on the operating hours of the spark 
plugs. Select the desired number of points for the curve from the No. of Points list. Enter the 
operating hours and the respective desired energy level for each point individually. If you select 
this energy mode, it is necessary to reset the operating hours counter of the spark plugs when 
the spark plugs are replaced. This setting can be made with menu item MIC-> Set spark plug 
runhours or with the HMI. 

  

 

Input of the operating hours 

Please note that the operating hours must be entered in ascending order. 
You can open a visualization of the data entered with the symbol Energy 
Curve. 

 Auto Spark Control (ASC) 
For the configuration of the spark duration, the ignition coil type must be defined under coil 
parameters. Selecting the function Auto Spark Control (ASC) in the energy mode area displays 
additional settings in the spark duration control area. These settings consist of the basic 
settings for drop-out energy and max. energy to 80%, for min. energy to 40%, and for the spark 
duration to 600 μs. The energy ranges can be adjusted between 20 and 100%, the spark 
duration can be set within a range of 100-1500 μs. 
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Operational Safety 

To use the ASC function of the MIC850, only ASC-capable MOTORTECH 
ignition coils may be used, which are marked with the ASC logo. 

  
 

8.10.10 Miscellaneous - Display 

 

Language 
Select the language for the controller display by mouse click. 

Display Settings 
– Brightness 

Enter the desired brightness for the controller display. 

– Timeout (Screensaver) 
Select the time after which the screensaver is to be activated. 

Units 
Select the desired unit (Celsius, Fahrenheit, or Kelvin) with which the temperatures shall be 
displayed on the controller. 
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8.10.11 Miscellaneous - Communication 

 

CAN 
Clicking on the field CAN enabled enables or disables the CANopen interface on the device.   

– ALL-IN-ONE (J1939)/CANopen 
Please select the desired protocol, depending on whether you want to set the 
communication for the ALL-IN-ONE or any other master control. If ALL-IN-ONE is selected, the 
CAN interface works always with 250 kBit/s. 

– Baudrate 
Select for the CANopen protocol the desired data transfer rate from the list. The CAN Baud 
rate can be defined between 10 kBit/s and 1 MBit/s, the recommended value being 250 
kBit/s. For communicating with a PowerView2, set it to 250 kBit/s, as well. 

– CANopen Node ID 
The CANopen node ID can be assigned between 1 and 123. The MIC850 takes up a total of 
five node IDs. Based on the node ID set, the four following IDs are then assigned. Please 
note that IDs cannot be assigned more than once. 
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Setting the transfer rate 

Please note that all equipment connected must be set to the same transfer 
rate. 

  
 

8.10.12 Miscellaneous - Contact Information 
This configuration page can be viewed by all users, but changes can only be made with 
authorization for the Service access level. 

 

Contact Information 
In this section, individual contact data can be saved that can be called up and displayed via 
MICT or HMI. 
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8.11  Runtime Data 

 

Click on the symbol to open the window Runtime Data. The following sections will give 
you an overview of the data you can view on the individual tabs. 

You can print and record the runtime data. For this purpose, the following functions are at your 
disposal in the toolbar in the window: 

Symbol Function 

 

Prints the runtime data.

 

Prints the runtime data to a PDF file.

 

Opens the print preview.

 

Starts recording a trace of runtime data.

 

Stops recording a trace of runtime data.

 
 



8 SETTINGS VIA THE MICT 
 
 

88 Rev. 07/2011 

8.11.1 Runtime Data - Overview 

 
In this screen, you can find the following information: 

– Speed indicator (analog) 

– Red pointer 
Indicates the current speed 

– Yellow pointer 
Indicates the max. speed reached 

– Speed indicator (digital) 
Digitally displays the current speed 

– Max. Speed 
Digital indication of the max. speed reached 
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– Timing Point indicator (analog) 

– Red pointer 
Indicates the current global timing 

– Yellow pointer 
Indicates most advanced/retarded global timing that occurred since opening this screen 

– Global Timing 
Digital indication of the current global timing 

– Base Timing 
Digital indication of the current base timing 

– Firing Enabled 
This status display shows if the ignition has been released. 

– Green 
released 

– Gray 
not released 

– Energy 
Digital indication of the current energy level 

– Schedule A/B 
The green status display shows which parameter settings are currently used. 

– System State 
Indicates the system status with the following possible messages: 

  

System status Description 

Initialization The initialization is running. 

Configuration The device is being configured. 

Ready The ignition is ready and waiting for pickup activity.

Self Test The self test is running.

Synchronization Pickup signals are being received and analyzed.

Firing locked Pickup signals are being received and are valid, ignition is 
not released. 

Wait for 0 RPM 

 

Pickup signals are being received, the ignition fired above 
the security speed, and the ignition release was retracted. 
The engine must now come to a standstill. 

Firing active The ignition is active.

Operational Error An operational error was detected.

System Error A system error occurred.
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– Error state 
A red status display shows that an error has occurred. For details, refer to the tab Error. 
Errors during engine operation result in the engine being shut down. 

– Warning state 
A red status display shows that a warning has occurred. For details, refer to the tab 
Warnings. Warnings do not result in the engine being shut down. 

– ASC State 
Indicates whether the Auto Spark Control (ASC) is activated. 

– Minimum Spark Duration 
Minimum spark duration that is currently reached. 

– Current Engine Operating Hours 
Indication of current operating hours of the engine. 

– Sparkplug Operating Hours 
Indicates the current operating hours of the spark plugs. 

 

8.11.2 Runtime Data - Timing 
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In this view, the system displays all values and settings in the left hand section that influence 
the ignition timing. In the right hand section, values are additionally displayed and shown as a 
bar chart that are measured at the three inputs (potentiometer, 4-20 mA and 0-5 V) and thus 
cause the changes to the timing shown. The value for the speed curve results from the curve 
progression set in the configuration. Refer to the section Timing - Schedule A/B on page 76. The 
timing correction can be implemented for the runtime. Refer to the section Runtime Adjustments 
- Timing on page 105. 
 

8.11.3 Runtime Data - Ignition 

 
The following information is provided: 

– Column: Output 
Identification of the output 

– Column: Cylinder 
Assigned cylinder name 

– Column: Angle [°crankshaft] 
Current ignition angle of the outputs of board A or B 



8 SETTINGS VIA THE MICT 
 
 

92 Rev. 07/2011 

  

Display by Cylinders 

For the display by cylinders in the runtime data the following steps are 
necessary: 

1. Name the cylinders on the configuration page Engine – Cylinder Names.

2. On the same configuration page you can make additional display 
settings (e.g. invert the order of the cylinders for display), if desired. 

3. Assign the cylinders to the ignition outputs on the configuration page 
Engine – Ignition Outputs. 

4. Enable the function via the menu entry Settings -> Display by cylinders. 

5. Download the modified configuration to the device. 

▸ In the window Runtime Data – Ignition the values are now displayed 
in the order of the cylinders 

  
 

8.11.4 Runtime Data - Board A and B 
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The following information is provided: 

– Column: Angle [°crankshaft] 
Current ignition angle of the outputs of board A or B (updated only while engine is running). 

– Column: Secondary Voltage [kV] 
Current secondary voltage of the respective output of board A or B. 

– Column: Spark Duration [μs] 
Current spark duration of the output. 

– Column: Rate [%] 
Current misfire rate of the respective output. 

– Column: primary 
Current misfire types on primary winding. In case of misfire, the status display turns red, 
otherwise it is gray. A yellow status display notifies the user of previous misfires that have 
occurred. 

– Column: secondary 
Current misfire types on secondary winding. In case of misfire, the status display turns red, 
otherwise it is gray. A yellow status display notifies the user of previous misfires that have 
occurred. 

You have the following option: 

– Reset Output Status Flags 
The status of the ignition controller outputs is reset. The status displays for the outputs turn 
gray again. 
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8.11.5 Runtime Data - Errors 
All system or operating errors cause the engine to be shut down. 

 
The following information is provided: 

– Time Stamp 
Status of the operating hours counter at which the error occurred. 

– Error ID 
The error ID is used to identify the error. 
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– Error 
Short description of the error. The following errors are possible: 

  

Error Description 

no error No error

trigger count Number of events per cycle counted does not correspond with set 
value. 

trigger missing Number of counted events is smaller than expected number.

cycle signal missing Cycle signal was not detected in time. More events were counted 
than is expected per cycle. 

reset count Number of reset events is outside expected range.

trigger period Current event period is outside the valid range with reference to 
the previous event period. 

pickup pre-processor  Pre-processor pickup causing errors.

overspeed Overspeed.

missing output board  Output board could not be detected.

SCR or HV error Thyristor error occurred / Problems with primary high voltage 
generator. 

misfire rate Misfire rate exceeded.

low power or shut-off Voltage too low.

general General error.

alarm shutdown The ignition is shut down due to an alarm.

reset by watchdog The device was restarted by the watchdog.

temperature The max. permissible device temperature was exceeded.

pickup signals in self 
test 

The self test was aborted because pickup signals were detected.

  
You have the following option: 

– Update 
With the Update button, you can manually update the error list displayed. If an error occurs, 
the list is updated automatically. Errors displayed in red have been added since the last 
activation of the device. 

– Show in reverse order 
Please activate the checkbox to reverse the order of the listed entries 
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Acknowledging an operating error 

While the engine is shut down, you have the following options for 
acknowledging operating errors:  

– with Acknowledge operational error in the MICT 

– with Acknowledge in the Error Commands screen in the HMI (optional) 

– Disconnecting the supply voltage 

– Press pushbutton PB1 on the controller for several seconds. 

  
 

8.11.6 Runtime Data - Warnings 
Contrary to errors, warnings do not result in the engine being shut down. 

 
The following information is provided: 

– Time Stamp 
Status of the operating hours counter at which the warning occurred. 
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– Warning ID 
The warning ID is used to identify the warning. 

– Warning 
Brief description of the warning. The following warnings are possible: 

  

Warning Description 

no warning No warning.

trigger count Number of events counted does not correspond with set value.

trigger missing Number of counted events is smaller than expected number.

cycle signal missing Cycle signal was not detected in time. More events were counted 
than is expected per cycle. 

trigger period Event period outside the expected range.

spurious trigger Event recognized as fault.

spurious reset Event recognized as fault.

reset count Number of reset events is outside expected range.

pickup pre-processor 
trigger number 

Number of events detected in the pre-processor pickup is outside 
the expected range. 

pickup pre-processor 
trigger missing 

Event period of pre-processor pickup is outside the expected 
range. 

pickup pre-processor 
index missing 

Pre-processor pickup could not detect index/reset event.

pickup pre-processor  Pre-processor pickup causes warning.

misfire rate Misfire rate exceeded.

overspeed Overspeed.

no ASC signal ASC signal was not detected. 

low power Voltage too low.

general General warning

display access lost Access to the display was lost. 

config data CRC error The configuration could not be read due to a CRC error.

short angle distance The distance between two ignitions is smaller than the minimum 
ignition spacing because of the timing correction. 
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You have the following option: 

– Update 
With the Update button, you can manually update the warning list displayed. If a warning 
occurs, the list is updated automatically. Warnings displayed in red have been added since 
the last activation of the device. 

– Show in reverse order 
Please activate the checkbox to reverse the order of the listed entries 

  

 

Acknowledging warnings 

You can acknowledge a warning by briefly pressing the pushbutton PB1 on 
the controller.  
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8.11.7 Runtime Data - Alarms 
Contrary to errors and warnings, which are specified by the ignition controller, up to 24 different 
alarms can be freely configured with the MICT. Refer to the section Outputs - Alarms on page 78. 

Under the runtime data, you can view an overview of alarms that occurred and which ones were 
acknowledged. Additionally, the system logs instances of a changed configuration being 
transferred to the MIC, as this will reset the alarms. 

 
The following information is provided: 

– Time Stamp 
Status of the operating hours counter at which the alarm occurred. 

– Alarm 
Number of the alarm in the configuration 

– Description 
Description of the alarm that was entered on the configuration page Outputs - Alarms. Refer 
to the section Outputs - Alarms on page 78. 



8 SETTINGS VIA THE MICT 
 
 

100 Rev. 07/2011 

– Event 
Shows which event has occurred. Possible events include: Alarm triggered, Alarm 
acknowledged, and Configuration changed. 

You have the following options: 

– Automatic scrolling 
If this box is checked, the system automatically displays the last list entry until a new event 
occurs. 

– Acknowledge alarms 
With this button, you can reset triggered alarms if they are no longer active. 

 

8.11.8 Runtime Data - Diagnostics 

 
The following information is provided: 

– Supply Voltage 
Current voltage supply of the controller circuit board. 



 
 
 

Rev. 07/2011 101 

– CPU Usage 
Current processor (CPU) usage in % 

– Pre-Trigger 
Current pre-trigger voltage 

– Current Temp. 
Current temperature of the controller board. 

– Min. Temp. 
Minimum temperature reached of the controller board. 

– Max. Temp. 
Maximum temperature reached of the controller board. 

– Output Board 
Output circuit board found 

– Green 
Output board found 

– Gray 
Output board not found 

– Current Temp.  
Current temperature of the output boards 

– Min. Temp. 
Minimum temperature reached of the output boards. 

– Max. Temp. 
Maximum temperature reached of the output boards. 
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8.11.9 Runtime Data - Information 

 
In this view, you can find an overview of the device and version data. In addition, you can print 
the current runtime data and, in case of problems, send them to the MOTORTECH service 
department via fax or as a PDF file via email. For fast support, we will then immediately have all 
required information available. 
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8.12  Log 

 

Click on the symbol to open the window Log. This window is only available to 
users with authorizations starting at the access level Advanced Service. 

 
The window Log serves to support error diagnostics by MOTORTECH.  

– Automatic scrolling 
If this function is activated, the display area focuses on the latest message. 

– Log level 
The selection of the Log Level is specified by MOTORTECH if needed. 

– Write log to file 
This check box activates or disables, respectively, the saving of the logged data in a 
selected file. If the function is disabled, the logged data are merely shown on the display. 

– Select file 
With this button, you can select a file to which you want to save the logged data. 

If you are prompted to create a log file in case of a service request, proceed as follows: 

1. Open the window Log via the toolbar or the menu bar. 

2. Select a path with the file selection button and enter the file name for the log file. 

▸ If the file does not yet exist, it is automatically created with the extension .log. 

3. Check the box Write log to file. 
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4. Select the level specified by MOTORTECH from the list Log level. 

5. Leave the window open. 

▸ The log messages are logged both in the window and in the selected file. 
 

8.13  Runtime Adjustments 

 

Click on the symbol to open the window Runtime Adjustments. This window is 
only available to users with authorizations starting with access level Service. 

  

 

Runtime adjustments are implemented directly. 

All runtime adjustments are implemented directly without requiring the 
input to be confirmed. The only exception to this is the adjustment of the 
self test period. 

  
 

8.13.1 Runtime Adjustments - Reset 

 
The index/reset position can be corrected by 5°crankshaft (advanced/retarded) while the 
controller is being operated. The correction is made with the keys: 

– 0.1 ADV/RET 
in 0.1° increments to advance or retard 

– 0.5 ADV/RET 
in 0.5° increments to advance or retard 

The correction of the index/reset position is immediately implemented and stored. If the 
correction range is not sufficient, the reset/index position must be adjusted in the configuration. 
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8.13.2 Runtime Adjustments - Timing 

 
The global timing position can be corrected by 50°crankshaft (advanced/retarded) while the 
controller is being operated. The correction is made with the buttons: 

– 0.1 ADV/RET 
in 0.1° increments to advance or retard 

– 0.5 ADV/RET 
in 0.5° increments to advance or retard 

The correction of the global timing point is immediately implemented and stored. The set value 
is also displayed in the runtime data. Refer to the section Runtime Data - Timing on page 90. The 
runtime adjustments cannot exceed or fall short of the limits set in the parameter settings for 
the timing point.  
 

8.13.3 Runtime Adjustments - Energy 

 
The output energy currently used by the ignition controller can be corrected while the controller 
is being operated. The correction is made with the keys: 

– +/- 1% 
increase or reduce in 1 % increments 

– +/- 10% 
increase or reduce in 10% increments 

The correction of the output energy is immediately implemented and stored. This setting has no 
effect during the start phase of the engine and while the spark duration control (ASC) is 
activated. If the energy was configured to depend on the operating hours of the spark plugs, the 
defined energy curve is offset by the adjustment value. 
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Limp Mode 

With a supply voltage below 18V, the MIC850 runs in the Limp mode and 
automatically limits the energy to 80%. 

  
 

8.13.4 Runtime Adjustments - Spark Duration 

 
The value for the spark duration can be changed while the controller is in operation. The change 
is made with the keys: 

– +/- 1 μs 
increase or reduce in 1 μs increments 

– +/- 10 μs 
increase or reduce in 10 μs increments 

The adjustment made only has an effect on the engine operation if the Auto Spark Control (ASC) 
was selected in the configuration. 
 

8.13.5 Runtime Adjustments - Self Test 

 
The self test function fires all configured outputs on a cycle. Select a value as desired between 
4000 μs and 1000000 μs for the time between two ignitions in the field Self Test Period and then 
click on the button Set to apply the value entered. The energy for the self test is determined on 
the basis of the configured energy settings. 
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8.14  Cylinder Individual Offsets 

 

Click on the symbol to open the window Cylinder Individual Offsets This window 
is only available to users with authorizations starting with access level Service. 

 
The cylinder individual offset can be applied to the position of the timing point while the 
controller is being operated. Offset via keys: 

– 0.1 ADV/RET 
in 0.1° increments to advance or retard 

– 0.5 ADV/RET 
in 0.5° increments to advance or retard 

The function offers an option for adjustment of max. 12.7°crankshaft in each direction. 

  

 

Immediate execution of the changes 

Please note that changes made to the timing point are executed 
immediately at the next firing of the corresponding cylinder. 
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Minimum Ignition Space 

For all timing corrections the device controls that the ignition space is not 
smaller than the minimum ignition space. Therefore it's possible that the 
offset of an individual cylinder can affect the timing of other cylinders. 

  
 

8.15  Energy Curve 

 

Click on the symbol to open the window Energy Curve. 

 
The representation of the energy curve results from the input for the energy depending on the 
operating hours of the spark plug, which were entered in the Energy level area. The symbol  
Current energy shows the current energy level and the operating hours of the spark plugs in the 
curve if the device is connected. 
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8.16  Schedule Curve 

 

Click on the symbol to open the window Schedule.

 
 

8.16.1 Schedule Curve - Simulation 

 
The schedule curve visualizes the configurations of the schedules and simulates the influence of 
the inputs via the speed range. With the optional input fields, you can switch between schedule 
A and B. Changes made by turning the control buttons or entering the desired values are 
displayed simultaneously. 

– Simulation 
The simulation is activated or disabled with the check box. 

– Potentiometer 
Simulation of the potentiometer 

– Control button for adjustments between 0% and 100% 

– Field for manual input of the desired value in % 

– Displays the value in °crankshaft by which the timing is offset 
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– 4-20 mA Input 
Simulation of the 4-20 mA input 

– Control button for adjustments between 0 mA and 20 mA 

– Field for manual input of the desired value in mA 

– Displays the value in °crankshaft by which the timing is offset 

– 0-5 V Input 
Simulation of the 0-5 V input 

– Control button for adjustments between 0 V and 5 V 

– Field for manual input of the desired value in V 

– Displays the value in °crankshaft by which the timing is offset 

– Schedule A/B 
Select parameter settings A or B 

– Timing Point 
Displays the global timing as it changes during the simulation. 

While connected to the device, the timing is simulated depending on the actual engine speed 
and marked in the chart as  . 
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8.16.2 Schedule Curve - Runtime Values 
If the box Simulation is unchecked, the window Schedule curve switches to the current runtime 
data. 

 
The following information is provided: 

– Schedule 
Displays the parameter settings currently selected. 

– Left column: Potentiometer, 4-20 mA Input, 0-5 V Input 
Displays the newly calculated adjustment values for the potentiometer, 4-20 mA and 0-5 V 
input. 

– Right column: Potentiometer, 4-20 mA Input, 0-5 V Input 
Displays the values supplied by the ignition controller for the potentiometer, 4-20 mA and 0-
5 V input. 

– Speed 
Displays the current speed. 

– Timing Point 
Displays the simulated global timing. 
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The Human-Machine Interface (HMI) is used to visualize the ignition and diagnostics data. It can 
be operated intuitively with eight keys. The user can navigate through the different views with 
menu controls or a closed-loop structure.  

With the HMI, you can view operating data and make adjustments while the engine is running. In 
addition, you can execute certain commands, such as acknowledging alarms or errors. The 
configuration settings, however, can only be implemented with the MICT (e.g. configuration of 
the parameter settings/schedule or the alarms). Some of the configuration data can be viewed 
with the HMI. 

The areas Commands and Runtime Adjustments are subdivided into different operating levels 
that can be secured with different PINs. If this access control is activated, a user is prompted to 
enter the PIN required for the respective level when they call up the corresponding views. 
 

9.1  HMI Design 
The HMI consists of a display and a control panel. In this case, the display shows the main view. 
This will be further explained in the following section. 
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9.1.1 Main View 
After starting the controller, the display shows the main view. This gives an overview of the most 
important ignition data. The main view of the HMI is organized in the following sections: 

– Timing 
This area shows the current timing based on the top dead center as a numerical value and in 
diagrammatic form. The bar chart shown is limited by the limits set. The current timing point 
is visualized by a wide bar, the base timing by a narrow bar. 

– Energy 
This area shows the current energy level in percent as a numerical value and a bar graph. 

– Speed range 
In this section, you can find the following information in addition to the current engine 
speed: 

–  
The symbol appears if alarms were configured with the MICT. At least one alarm must 
have been configured for which the results are logged. If no such alarm is configured, 
the symbol does not appear. If an alarm occurs, the symbol flashes. The alarm can then 
be acknowledged with the MICT or the HMI. The latter is possible only if the threshold 
given in the alarm condition is no longer being exceeded or not reached.  

–  
The symbol indicates that the access control is activated. If you have entered the PIN for 
an operating level, the lock opens and is displayed with the number of the operating 
level. 

– A or B 
A or B indicate the current parameter settings that were set with the corresponding 
input on the controller. 

– Status bar 
The status bar shows the operating status of the ignition controller. 
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9.1.2 Keys of the Control Panel 
You can operate the functions of the HMI with the control panel underneath the display. The 
following table gives an overview of the keys and their functions. 

Key Function 

 

Main Menu
With this key, you can access the main menu through which you can call 
up other submenus. 

 

Help/Service Contact
In this view, you can call up a context sensitive help page with this key, 
in which the operating options of the respective view are described 
briefly.  

 
Pushing the help key twice will open the view Service contact. The 
information given there can be managed with the MICT. Refer to the 
section Miscellaneous - Contact Information on page 86. 

 

 

Close/Main View
With this key, you can close the view you are currently in back to the 
starting level, or you can switch directly to the main view. 
In the main view, you can switch off the display with this key (not the 
controller). 
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Key Function 

 

Acknowledge
With this key, you can confirm a selection or input and switch to the 
next view. 

 

  

 

Navigation
With the navigation keys, you can move within the views and menus or 
set the input values. 

 
 

9.2  General Operation 

9.2.1 Operation with Menu Controls or Closed-Loop Structure 
In Principle, there are two Options for Operating the HMI: 

– operation using the menus shown on the display, starting with the main menu 

– operation by scrolling through a pre-defined closed-loop structure for the runtime data, 
starting with the main view 

Operation with Menu Controls 

Starting with the main menu, which you can open in all views with the button  , you can 
access all areas of the user interface via additional submenus. Select a menu entry using the 

navigation keys  and  and acknowledge the selection with the button . As an example, 
below is a screenshot of the main menu: 
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Operation with closed-loop structure 

Using the navigation keys  and  you can scroll through the pre-defined runtime data loop 
in which important views of the runtime data are organized in a closed-loop structure. The loop 
comprises the views Schedule A/B, Firing Angle, Misfire, Secondary Voltage Counter, Operating 
hours overview, Errors, Warnings, Alarms, Diagnostics, Temperatures, and Information, and can 
only be called up from the main view with this method. 

In addition, you can access the menus Runtime Adjustments and Commands directly from the 

main view using the buttons  and . 

 
 

9.2.2 Conventions Used in the Following 
In the subsequent sections, the views will be explained that provide you with information or 
allow you to enter settings. The path for accessing the respective view is indicated with a short 
hand notation. 

In this short hand notation, an arrow connects the individual steps (->). The menu and the entry 
in the menu to be selected are separated by a colon (:). The following example illustrates the 
short hand notation. 
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Short hand notation 

 -> Main Menu: Commands -> Commands: Set Sparkplug Hours -> Set Sparkplug Hours 

Meaning 

1. Open the main menu with the button  in the control panel. 

2. Select the entry Commands from the main menu. 

▸ The Commands menu is being displayed. 

3. Select the entry Set Sparkplug Hours from the Commands menu. 

▸ The view Set Sparkplug Hours is being displayed. 
 

9.3  For Diagnostics 
With the menu Runtime Data, you can access diagnostics information that offers you an overview 
of your system. You can access the menu as follows: 

Main View ->  -> Main Menu Runtime Data -> Runtime Data 

or 

Main View ->  -> Runtime Data 

For the other views, only the paths via the main menu will be described. 

The diagnostics information supports your troubleshooting and engine maintenance activities. 
For example, an increased secondary voltage demand indicates wear of individual spark plugs, 
or the misfire overview can show a wire rupture or a short circuit. 
 

9.3.1 Viewing a Schedule 
The information concerning the currently used parameter settings can be accessed as follows: 

 -> Main Menu: Runtime Data -> Runtime Data: Schedule -> Schedule A or B 
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In this view, you can find the following information: 

– Base  
Currently used base timing point that was configured with the MICT. 

– Potentiometer 
Timing correction set with the respective potentiometer (A or B). 

– 4-20 mA  
Timing point correction resulting from the 4-20 mA input. 

– 0-5 V 
Timing point correction resulting from the 0-5 V input. 

– Speed Curve  
Timing point correction resulting from the set speed curve. 

– Timing Correction. 
Timing point correction that is transmitted via the CAN bus or implemented manually. 

– Global Timing 
Global ignition angle. This value results from the sum of the preceding values. 

 

9.3.2 Viewing Firing Angles 
The ignition angle information can be accessed as follows: 

 -> Main Menu: Runtime Data -> Runtime Data Firing Data -> Firing Data: Firing Angle -> Firing 
Angle 

 
This view will show you the current ignition angle for each of the twelve outputs of the output 
boards A/B. In the top row, the outputs 1-6 are shown, the lower row shows outputs 7-12. You 
can see in the overview whether a cylinder individual offset was applied to an ignition angle (e.g. 
by a detonation control). 
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9.3.3 Viewing Misfires 
The misfire information can be accessed as follows: 

 -> Main Menu: Runtime Data -> Runtime Data: Firing Data -> Firing Data: Misfire -> Misfire 

 
This view gives you the following information on all twelve outputs of the output boards A/B: 

– Misfire rate in % for the respective output 

– Misfire types of the misfires that have occurred up to this point: 

–  Short circuit, primary winding 
(is currently not supported) 

–  Idle primary winding 

–  Short circuit secondary winding 

–  Idle secondary winding 

You can call up the overview of the misfire types at any time using the key  in the control 
panel. If misfiring occur, the causes for them must be found and eliminated. The overview 
supports you in locating the error and narrow it down. 
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9.3.4 Viewing Secondary Voltage 
The secondary voltage information can be accessed as follows: 

 -> Main Menu: Runtime Data -> Runtime Data: Firing Data -> Firing Data: Secondary Voltage -> 
Secondary Voltage 

 
This view will show you the current secondary voltage for each of the twelve outputs of the 
output boards A/B. An increased secondary voltage demand indicates that the corresponding 
spark plug is worn. Extremely low values point to a problem with the compression performance 
of the cylinder. 
 

9.3.5 Viewing the Spark Duration 
The spark duration information can be accessed as follows: 

 -> Main Menu: Runtime Data -> Runtime Data: Firing Data -> Firing Data: Spark Duration -> 
Spark Duration 

 
This view will show you the current spark duration for each of the twelve outputs of the output 
boards A/B. The spark duration also provides information on problems in the cylinder and spark 
plug area, similar to the secondary voltage. 
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9.3.6 Viewing the Operating Hours Counter 
The operating hours counter can be accessed as follows: 

 -> Main Menu: Runtime Data -> Runtime Data: Counter -> Counter 

 
In this view, you find information on the following operating hours: 

– MIC 
Operating hours of the ignition controller (includes times without pickup signals) 

– All Engines 
Runtime of the MIC850 on all engines that the device was operated with. 

– This Engine 
Corresponds with the runtime of the engine on the (all) ignition controller if the engine 
runtime was correctly set via MICT or HMI when the MIC850 was first used. 

– Spark Plug 
Operating hours of the spark plugs 

 

9.3.7 Viewing Errors and Error Details 
All operating errors that occurred are compiled in an error list. You can call up a detail view for 
each error. 

Error overview 
The overview of the errors that have occurred can be accessed as follows: 

 -> Main Menu: Runtime Data -> Runtime Data: Error -> Error 
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In this view, you can find the following information: 

– Lifetime 
Current operating time of the ignition controller 

– Time Stamp 
Operating time at which the adjacent error occurred. 

– Code 
Error code of the error. For explanations for the possible errors, please refer to section 
Runtime Data - Errors on page 94. 

Error details 
You can display details on any error shown in the overview. The detail view can be accessed as 
follows: 

 -> Main Menu: Runtime Data -> Runtime Data: Error -> Error -> Select error -> Error Details 

 
Aside from the values already given in the overview (operating time, timestamp, code), the view 
supplies you with additional detail information on the different errors. Contrary to the indication 
in the error overview, the timestamp is given including thousandths of a second. This 
information helps differentiate errors that occurred almost simultaneously. 

– With the navigation keys  and  you can open the details for the preceding or 
subsequent error in the alarm list. 
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9.3.8 Viewing Warnings and Warning Details 
All warnings that occurred are compiled in a warning notice list. You can call up a detail view for 
each warning. 

Warning overview 
The overview of the warnings that have occurred can be accessed as follows: 

 -> Main Menu: Runtime data -> Runtime Data Warnings -> Warnings 

 
In this view, you can find the following information: 

– Lifetime 
Current operating time of the ignition controller 

– Time Stamp 
Operating time at which the adjacent warning occurred. 

– Code 
Code of the warning. For explanations for the possible warnings, please refer to section 
Runtime Data - Warnings on page 96. 

Warning Details 
You can display details on any warning shown in the overview. The detail view can be accessed 
as follows: 

 -> Main Menu: Runtime Data -> Runtime Data Warnings -> Warnings -> Select warning -> 
Warning details 
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In addition to the values already given in the overview (operating time, timestamp, code), the 
view supplies additional detail information on the different warnings. Instead of the information 
in the warning overview, the timestamp is given including thousandths of a second. This 
information helps differentiate warnings that occurred almost simultaneously. 

– With the navigation keys  and  you can open the details for the preceding or 
subsequent warning in the warning list. 

 

9.3.9 Viewing Alarms and Alarm Details 
Contrary to errors and warnings, which are specified by the ignition controller, up to 24 different 
alarms can be freely configured with the MICT. In the runtime data, you can view an overview of 
the alarms that have occurred and details for each alarm. You can acknowledge an alarm that 
has occurred via the menu Commands. 

Alarm overview 
The overview of the alarms that have occurred can be accessed as follows: 

 -> Main Menu: Runtime Data -> Runtime Data: Alarms -> Alarms 

 
The overview shows the latest five alarm events that occurred. All other alarms can be viewed 
with the MICT. In this view, you can find the following information: 

– Lifetime 
Current operating time of the ignition controller 

– Time Stamp 
Operating time at which the adjacent alarm occurred. 

– ID 
Number of the alarm that was selected in the alarm configuration in the MICT for the 
corresponding alarm. 

– Description 
Brief description of the alarm that was entered in the MICT. 

– Event 
Abbreviated descriptions for one of the following events: 

– TRIGGER 
The alarm was triggered. 
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– ACK 
The alarm was acknowledged. 

– CONFIG 
The configuration was modified via the MICT - all alarms were reset. 

Alarm Details 
You can display details on any alarm shown in the overview. The detail view can be accessed as 
follows: 

 -> Main Menu: Runtime Data -> Runtime Data: Alarms -> Alarms -> Select alarm -> Alarm Details 

 
In the detail view, you can find information on the alarms in a slightly more detailed 
representation. 

– With the navigation keys  and  you can open the details for the preceding or 
subsequent alarm in the alarm list. 

 

9.3.10 Viewing Diagnostics 
In the diagnostics view, you can obtain an overview of the key figures of internal processes and 
the values currently active at the inputs. 

The diagnostics information can be accessed as follows: 

 -> Main Menu: Runtime Data -> Runtime Data: Diagnostics -> Diagnostics 
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In this view, you can find the following information: 

– Max. Speed 
Max. speed since the last start-up of the MIC850 and the engine. If only the MIC850 was 
restarted and the engine does not yet run, the previous max. value is indicated. 

– CPU Usage 
Current processor usage of the ignition controller CPU 

– Supply Voltage 
Current supply voltage of the ignition controller 

– Pre-Trigger 
Pre-Trigger voltage set in the MICT that controls the pickup sensitivity. 

– 4-20 mA 
Current value at the 4-20 mA input 

– 0-5 V 
Current value at the 0-5 V input 

– ASC State 
Indicates whether the Auto Spark Control (ASC) was activated in the MICT. 

– Min Spark Dur. 
Minimum spark duration that is currently reached. 

– Energy 
Current energy level 

 

9.3.11 Viewing the Temperatures 
The information on the current temperatures of the ignition controller can be accessed as 
follows: 

 -> Main Menu: Runtime Data -> Runtime Data Temperatures -> Temperatures 

 
In this view, you can find the following information: 

– CPU 
Aside from the current temperature value of the CPU board, the min. and max. values are 
given that were measured since the last activation of the controller. 
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– Out A and B 
Aside from the current temperature values of the output boards A and B, the min. and max. 
values are given that were measured since the last activation of the controller. 

– CPU Max. and Output Max. 
If the max. values given below the table are measured for more than one minute on any of 
the corresponding circuit boards, the engine and controller are shut down. 

 

9.3.12 Viewing Information 
Further ignition controller information can be accessed as follows: 

 -> Main Menu: Runtime Data -> Runtime Data: Information -> Information 

 
In this view, you can find the following information: 

– Device ID 
The device ID serves to internally identify the device type. 

– Arrangement 
The arrangement number provides information on the type of the ignition controller and the 
number of output boards and outputs, amongst other things. 

– Serial  
The controller can be unambiguously identified with the serial number. It is needed for 
service requests. 

– Lifetime 
Current operating time of the ignition controller 

– Hardware 
Version number of the hardware used in the ignition controller 

– Software 
Version number of the software used in the ignition controller 

– Bootloader 
Version number of the bootloader 

– Display 
Version number of the display software used in the ignition controller 
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9.4  During Engine Operation 
During engine operation, you can make adjustments via the menu Runtime Adjustment. The 
menu can be accessed as follows: 

Main View ->  -> Main Menu: Runtime Adjustment -> Runtime Adjustment 

or 

Main View ->  -> Runtime Adjustment 

For the other views, only the paths via the main menu will be described. 

  

 

Runtime adjustments are implemented directly. 

All runtime adjustments are implemented directly without requiring the 
input to be confirmed. The only exception to this is the adjustment of the 
self test period. 

  
 

9.4.1 Setting the Reset Position 
The setup for the reset position can be accessed as follows: 

 -> Main Menu: Runtime Adjustment -> Runtime Adjustment: Reset Position -> Reset Position 

 
In this view, you can find the following information: 

– Reset 
The reset position currently set via the MICT is marked in the chart at the center with a short 
line. You can adjust the reset position by max. 5°crankshaft in both directions 
(advance/retard). Adjacent to the chart, the currently set value is given based on the top 
dead center. If the correction range is not sufficient, the reset position must be adjusted in 
the configuration via the MICT. 

– Adjustment 
Currently set adjustment value 
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You have the following option: 

– Adjust the reset position with the navigation keys in 0.1° or 0.5° increments. 
 

9.4.2 Setting the Timing 
The setup for the timing point can be accessed as follows: 

 -> Main Menu: Runtime Adjustment -> Runtime Adjustment: Timing -> Timing 

 
In this view, you can find the following information: 

– Timing 
The currently set base timing point set via the MICT is marked in the chart at the center with 
a short line. You can correct the timing point within the configured timing point limits. 
Adjacent to the chart, the currently set value is given based on the top dead center. 

– Adjustment 
Currently set adjustment value 

You have the following option: 

– Adjust the timing point with the navigation keys in 0.1° or 0.5° increments. 

Also, a cylinder individual offset can be applied to the timing point with the MICT. Please refer to 
the section Cylinder Individual Offsets on page 107. 
 



9 SETTINGS VIA THE HMI 
 
 

130 Rev. 07/2011 

9.4.3 Setting the Energy 
The setup of the ignition energy can be accessed as follows: 

 -> Main Menu: Runtime Adjustment -> Runtime Adjustment: Energy -> Energy 

 
In this view, you can find the following information: 

– Energy 
The energy level can be set between 20% and 100%. The default value of 80% is marked in 
the graphical representation with a short line. The currently set value is given next to the 
chart. 

– Adjustment 
Currently set adjustment value 

You have the following option: 

– Adjust the energy level with the navigation keys in 1% or 10% increments. 
This setting has no effect during the start phase of the engine and while the spark duration 
control (ASC) is activated. If the energy was configured to depend on the operating hours of 
the spark plugs, the defined energy curve is offset by the adjustment value. 

 

9.4.4 Auto Spark Control Setup 
The setup for the spark duration control (ASC) can be accessed as follows:  

 -> Main Menu: Runtime Adjustment -> Runtime Adjustment: Auto Spark Control -> Auto Spark 
Control 
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In this view, you can find the following information: 

– ASC 
The spark duration can be set within a range between 100 and 1500 μs. The default value of 
600 μs is marked in the graphical representation with a short line. The currently set value is 
given next to the chart. 

– Adjustment 
Currently set adjustment value 

You have the following option: 

– Adjust the spark duration with the navigation keys in 1 μs or 10 μs increments. 
This setting only takes effect if the spark duration control (ASC) is activated. The nominal 
value for the Auto Spark Control is changed by adjusting the spark duration. 

 

9.4.5 Setting the Self Test Period 
You can set the period for the self test. This period defines the time between two ignitions 
during the self test. You can start the self test from the menu Commands. The setup for the self 
test period can be accessed as follows: 

 -> Main Menu: Runtime Adjustment -> Runtime Adjustment: Self Test Period -> Self Test Period 

 
In this view, you can find the following information: 

– Period 
The self test period can be set within a range between 4 and 1000 ms. The default value of 
500 ms is marked in the graphical representation with a short line. The currently set value is 
given next to the chart. 

You have the following options: 

– Adjust the self test period with the navigation keys in 10 μs or 100 μs increments. Contrary 
to the other engine data settings, this setting is not directly transferred. 

– Set 

Confirm your adjustment with this key . 

– Cancel 

Cancel your adjustment with this key . 
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9.5  In Case Service is Needed 
Important settings for service requests can be accessed via the menu Commands. The menu can 
be accessed as follows: 

Main View ->  ->Main Menu: Commands -> Commands 

or 

Main View ->  -> Commands 

For the other views, only the paths via the main menu will be described. 

With the commands, some settings can be made for the corresponding views in the runtime 
data. In addition, you get direct access to important runtime data (e.g. errors, warnings, alarms, 
counters). 
 

9.5.1 Calling up Alarm Commands 
The view Alarm Commands gives you an overview of which of the 24 possible alarms were 
configured with the MICT, and which alarms are currently active. 

The alarm commands can be accessed as follows: 

 -> Main Menu: Commands -> Commands: Alarm commands -> Alarm commands 

 
In this view, you can find the following information: 

– IDs of the 24 freely configurable alarms that were defined in the MICT. 

– The bell symbol marks the alarms in general that were configured in the MICT. If the bell 
symbol is displayed in white, the respective alarm has occurred and has not yet been 
acknowledged. 

You have the following options: 

– Acknowledge 
This option is only available when an alarm is active.  

With the key  you can acknowledge all alarms that have occurred and the alarm condition 
for which is no longer fulfilled. 
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– Cancel 
This option is only available when an alarm is active. 

With the key  you can exit the view without acknowledging the alarms. 

– Events 

With the key  you can switch to the alarm list. Refer to the section Viewing Alarms and 
Alarm Details on page 124. 

– Alarms 

With the key  you can switch to the alarm configuration. For more information, also read 
the following section. 

Alarm Configuration 
For more detailed information on the alarms, you can view the alarm configuration that was 
implemented with the MICT. However, you cannot make changes via the HMI. 

The alarm configuration can be accessed as follows:  

 -> Main Menu: Commands -> Commands: Alarm commands -> Alarm commands: Alarms -> 
Alarm Configuration 

 
In this view, you can find the following information: 

– ID 
IDs of the 24 freely configurable alarms that were defined in the MICT. 

– Description 
Description of the alarm that was assigned in the MICT. 

– Flags 
The flags correspond with the settings for the alarm in the MICT: 

– S 
The setting Engine Shutdown is activated. 

– P 
The setting Permanent – Keep output activated until alarm is acknowledged is active. 

– L 
The setting Log Events is activated. 
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– 1-3 
The numbers indicate the outputs (GPO1, GPO2, GPO3) that were activated for the alarm. 

You have the following option: 

– Select an alarm from the list using the navigation keys. 

With the key  you can open the details of the alarm configuration for the alarm selected. 
For more information, also read the following section. 

Alarm [ID] Details 
In the detail view, you can view the further configuration settings of the alarms. The details of 
the alarm configuration can be accessed as follows: 

 ->Main Menu: Commands -> Commands: Alarm commands -> Alarm commands: Alarms -> 
Alarm Configuration -> Select Alarm -> Alarm [ID] Details 

 
The configuration settings are edited with the MICT and are described in the corresponding 
section Outputs - Alarms on page 78. 
 

9.5.2 Calling up Error Commands 
With the error commands, you can acknowledge operating errors. This can only be implemented 
while the engine is standing still. 

The error commands can be accessed as follows: 

 -> Main Menu: Commands -> Commands: Error Commands -> Error Commands 
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In this view, you can find the following information: 

– Lifetime 
Current operating time 

– Time Stamp 
Operating time at which the error occurred. 

– Error Code 
Error code of the error. 

You have the following options: 

– Acknowledge  
This option is only available when an error has occurred. 

With the key  you can acknowledge all operating errors when the engine stands still. If an 
error was triggered by an alarm, the alarm must first be acknowledged. 

– Cancel 
This option is only available when an error has occurred. 

With the key  you can exit the view without acknowledging an error. 

– Errors 

With the key  you can switch to the error list. Refer to the section Viewing Errors and Error 
Details on page 121. 

– Warnings 

With the key  you can switch to the warning list. Refer to the section Viewing Warnings 
and Warning Details on page 123. 

 

9.5.3 Resetting the Output Status 
The output status can be accessed as follows: 

 -> Main Menu: Commands -> Commands: Output Status -> Output Status 
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In this view, you will find the following information on the individual outputs on the output 
boards A and B: 

–  Short circuit primary winding 

–  Idle primary winding 

–  Short circuit secondary winding 

–  Idle secondary winding 

  
You have the following options: 

– Reset 

With the key  the status of all outputs is reset. If the cause for the short or idle was not 
eliminated, the output status is immediately displayed again after the reset. 

– Cancel 

With the key  you can exit the view. 

– Angle 

With the key  you can switch to the ignition angle view. Refer to the section Viewing Firing 
Angles on page 118. 

– Sec. Voltage 

With the key  you can switch to the secondary voltage view. Refer to the section Viewing 
Secondary Voltage on page 120. 

 

9.5.4 Setting the Engine Hours 
If you use the ignition controller on an engine that has already been running for a period of time, 
you can set the operating counter to the value of the operating hours already completed. This 
way, the engine operating hours are continuously measured correctly. The view in which you can 
set the engine operating hours can be accessed as follows: 

 -> Main Menu: Commands -> Commands: Set Engine Hours -> Set Engine Hours 

 



 
 
 

Rev. 07/2011 137 

In this view, you can find the following information: 

– Current  
Operating hours currently stored in the MIC850 for the engine 

– New 
Newly set value for operating hours 

You have the following options: 

– Under New, set the desired value for the operating hours using the navigation keys. 

– Set 

With the key  you can confirm the value set under New for the operating hours. 

– Cancel 

With the key  you can discard the value set under New for the operating hours. 
 

9.5.5 Setting the Sparkplug Operating Hours 
You can set the value for the spark plug operating hours or reset the value to zero when you 
replace the spark plugs. This is predominantly required in cases where the energy mode is 
selected to be based on the operating hours of the spark plugs. Refer to the section Energy - 
Energy Level on page 82. 

The view in which you can set the spark plug operating hours can be accessed as follows: 

 -> Main Menu: Commands -> Commands: Set Sparkplug Hours -> Set Sparkplug Hours 

 
In this view, you can find the following information: 

– Current  
Value for spark plug operating hours currently stored on the controller 

– New 
Newly set value for operating hours 

You have the following options: 

– Under New, set the desired value for the spark plug operating hours using the navigation 
keys. 
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– Set 

With the key  you can confirm the value set under New for the spark plug operating hours. 

– Cancel 

With the key  you can cancel the value set under New for the spark plug operating hours. 
 

9.5.6 Running a Self Test 
You can start a self test during which the individual cylinders of the engine are fired in the 
ignition sequence. The time between two ignitions is defined by the self test period. Refer to the 
section Setting the Self Test Period on page 131. The view in which you can start the self test can 
be accessed as follows: 

 -> Main Menu: Commands -> Commands: Self Test -> Self Test 

 
In this view, you can find the following information: 

– Energy 
During the self test, the chart shows the current energy level.. The value depends on the 
energy settings in the configuration. Changing the energy level (via HMI or MICT) during the 
self test can be helpful for diagnosing problems. 

– Period  
Currently set self test period 

You have the following options: 

– Start 
Before starting the self test, please take note of the following safety instruction. With the 

key  you can start the self test. The latter will run until it is manually stopped again. 
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Operational Safety 

If you use the self test function, it is compulsory to shut off the gas feed line 
and all cylinders are purged of fuel. Non-compliance can result in damage 
to equipment or injury to persons. 

  
– Stop 

When the self test is running, you can end it with the key  again. 
 

9.6  Display Settings 
All display settings implemented directly on the HMI are stored only temporarily. At every new 
start of the controller, the display settings will be used that are stored in the configuration that 
was downloaded from the MICT to the controller. You can access the display settings via the 
menu Display options. The menu can be accessed as follows: 

Main View ->  ->Main Menu: Display Settings -> Display Settings 
 

9.6.1 Adjusting the Brightness 
The brightness settings can be accessed as follows: 

 -> Main Menu: Display Settings -> Display Settings: Brightness -> Brightness 

 
In this view, you can find the following information: 

– Brightness 
Currently set brightness of the display 
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You have the following options: 

– Adjust the brightness level with the navigation keys in 1% or 10% increments. The available 
range is 0-100%, the default setting is 90%. Uninterrupted operation at the 100% setting is 
not recommended, as this will make the display age more rapidly. 

– Set 

Confirm your adjustment with this key . 

– Cancel 

Cancel your adjustment with this key . 
 

9.6.2 Set Timeout 
The timeout setting of the display can be accessed as follows: 

 -> Main Menu: Display Settings -> Display Settings: Timeout -> Timeout 

 
In this view, you can find the following information: 

– Timeout 
Currently set period after which the display switches off. 

You have the following options: 

– Adjust the timeout via the navigation keys in 1 or 10 minute increments. The timeout can be 
set within a range between 0 and 240 minutes. The setting 0 corresponds with the 
uninterrupted operation of the display. The default setting is 30 minutes. It is recommended 
to switch off the display while it is not needed, as this will increase its service life. 

– Set 

Confirm your adjustment with this key . 

– Cancel 

Cancel your adjustment with this key . 
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Automatic logout when deactivating the display 

If the access control was activated in the MIC850, all operating levels are 
automatically logged out when the display is switched off. 

  
 

9.6.3 Setting the Language 
The language setup of the HMI can be accessed as follows: 

 -> Main Menu: Display Settings -> Display Settings: Language -> Language 

 
You have the following options: 

– Select the desired language with the navigation keys  and    

– Set 

Confirm your selection with the key . 

– Cancel 

Cancel your selection with the key . 
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9.6.4 Setting the Temperature Units 
The temperature unit setup can be accessed as follows: 

 -> Main Menu: Display Settings -> Display Settings : Temperature -> Temperature 

 
You have the following options: 

– Select the desired unit (Celsius, Kelvin, Fahrenheit) for the temperatures using the 

navigation keys  and . 

– Set 

Confirm your selection with the key . 

– Cancel 

Cancel your selection with the key . 
 

9.7  Access Control 
If the access control is activated, access to the following areas is possible with a PIN only: 

– Runtime Adjustment (Reset, timing, ignition energy, Auto Spark Control (ASC), and self test 
period) 

– Commands (Alarms, error commands, set engine/spark plug operating hours, and self test). 

The access control controls the access to the controller with both the HMI and the MICT. For 
explanations concerning access control to the MIC850 and the delimitation of the access levels 
in the MICT, refer to section Access Control on page 54. 

The menu Access Control can be accessed directly via the main menu. 
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9.7.1 Activating the Access Control 
  

 

Enabling and disabling access controls 

As a default setting, the access control is not activated, and all PINs are set 
to 0000. Once the access control has been activated, and the PINs were 
changed, these PINs will continue to be used. To activate the access 
controls again, you will need the PIN for level 3 (Master). It is therefore 
recommended to reset all PINs before disabling. 

If that was not done, or a system must be unlocked for another reason, a 
request key can be issued in the MICT. Refer to the section Resetting all 
PINs on page 64. 

  
The view in which you can activate the access control can be accessed as follows: 

 -> Main Menu: Access Control -> Access Control: Enable Access Control -> Enable Access 
Control 

 
You have the following options: 

– PIN 
Enter the PIN for level 3 using the navigation keys. 
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– Confirm 

With the key  you can acknowledge the PIN entered. 
After acknowledging the PIN, the following view opens: 

 
 

With the key  you can access the Access Control view, in which you can finish activating 
the access control with the menu item Logout. 

– Cancel 

With the key  you can cancel the PIN entered. 
 

9.7.2 Login 
Once the access controls are activated, you can log in for the respective operating levels to then 
access the views that pertain to the respective level.  

The log-in view can be accessed as follows: 

 -> Main Menu: Access Control -> Access Control: Login -> Login 

 
You have the following options: 

– Level 
First select the level you wish to log in to via the navigation keys. 

– PIN 
Enter the PIN for the desired level using the navigation keys. 
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– Login 

With the key  you can acknowledge the PIN entered. 

– If you entered the PIN correctly, the access control menu is opened. 

– If you entered the PIN incorrectly, the system shows the message that access is denied. 
You can repeat the input, but a hold view opens first on which the wait time is counted 
down. This time increases with each failed attempt. This system is designed to prevent 
potential intruders from systematically trying out all possible combinations. 

 

– Cancel 

With the key  you can cancel the PIN entered. 
 

9.7.3 Logout 
If you are logged in to an operating level, the entry Logout is available in the menu Access 
Control. In addition, you can specifically log out of an operating level and continue to work on a 
different level via the entry Change level. If the display is switched off either automatically or 
manually, the system will log the user out automatically. 
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9.7.4 Changing Levels 
If you are logged into a specific operating level, you can switch to a higher or lower operating 
level. This is an alternative procedure to logging in and out for different levels. 

The view in which you can change levels can be accessed as follows: 

 -> Main Menu: Access Control -> Access Control: Login -> Login -> Enter PIN for level 3 -> Access 
Control: Change Access Level -> Login 

 
The view depends on the level you are logged into and if you wish to switch to a higher or a lower 
level. Changing to a higher level is implemented with a log-in for which the respective PIN is 
required. Switching to a lower level is implemented by logging out of the respective 
superordinate level. 

  

 

Changing to a lower level 

A user is logged in to level 3 and would like to switch to level 1. He selects 
level 2 in the view and then acknowledges the log-out from level 2 via 
Logout. The view shows that the user is then logged on to level 1. He can 
then exit the view with Cancel. 

  
The operating options in the view are therefore identical with those for log-in or log-out. 
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9.7.5 Changing the PIN 
To change the PIN for an operating level, you must first enter the current PIN for this level. The 
view in which you can change the PIN can be accessed as follows: 

 -> Main Menu: Access Control -> Access Control: Change PIN -> Change PIN 

 
You have the following options: 

– First, enter the PIN you would like to change using the navigation keys. 

– Confirm 

With the key  you can acknowledge the PIN entered.  

 
Enter the new PIN and confirm it. You will be prompted to enter the new PIN again. Once you 
confirm the new PIN again, the PIN is changed. 

– Cancel 

With the key  you can cancel the PIN entered. 
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9.7.6 Resetting all PINs 
If you have authorization for accessing level 3, you can reset all PINs to the default setting 0000. 
The view in which you can reset all PINs can be accessed as follows: 

 -> Main Menu: Access Control -> Access Control: Reset All PINs -> Reset All PINs 

 
You have the following options: 

– Enter the PIN for level 3 using the navigation keys. 

– Confirm 

With the key  you can acknowledge the PIN entered. 
All PINs are reset to 0000. 

– Cancel 

With the key  you can cancel the PIN entered. 
The PINs are not reset. 

 

9.7.7 Disabling the Access Control 
  

 

Enabling and disabling access controls 

As a default setting, the access control is not activated, and all PINs are set 
to 0000. Once the access control has been activated, and the PINs were 
changed, these PINs will continue to be used. To activate the access 
controls again, you will need the PIN for level 3 (Master). It is therefore 
recommended to reset all PINs before disabling. 

If that was not done, or a system must be unlocked for another reason, a 
request key can be issued in the MICT. Refer to the section Resetting all 
PINs on page 64. 
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The view in which you can disable the access control can be accessed as follows: 

 -> Main Menu: Access Control -> Access Control: Disable Access Control -> Disable Access 
Control 

 
You have the following options: 

– Enter the PIN for level 3 using the navigation keys. 

– Confirm 

With the key  you can acknowledge the PIN entered. 
The access control is disabled. 

– Cancel 

With the key  you can cancel the PIN entered. 
The access control remains activated. 

 

9.8  Error 

9.8.1 System / Operating Errors 
If a system or operating error occurs, the display is activated, and the corresponding error 
message is displayed. The display remains switched on until the error message was closed. 

    
The following information is provided: 

– Time stamp 
Operating time at which the error occurred. 
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– System Error/Operational Error 
Error type. 

You have the following options: 

– Close the error message with the key . 

– Switch to the error and warning view to analyze the problem in more detail, e.g. via 

 -> Main Menu: Commands -> Commands: Error Commands-> Error Commands 

– The MIC850 will not be ready for firing up the engine until the error was eliminated and 
acknowledged. 

 

9.8.2 Software Installation Errors 
The following display appears if the HMI software could not be installed after the firmware 
update. The MIC850 is then not in the system state Ready. 

 
You have the following options: 

– Set the MIC850 to the status Ready and repeat the HMI installation by acknowledging the 

warning with the  key. This is the recommended procedure. 

– Ignore the warning and cancel the update with the key . You can then continue to work 
with the old status of the HMI software. If the HMI software version is outdated, the ignition 
performance of the MIC850 is not affected. Merely display errors may occur on the screen. 
Upon restarting the ignition controller, the system will automatically attempt to update the 
HMI software. 
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10.1  Start-Up 
Before you start up the MIC850 ignition controller, take note of the following:  

– Were the correct engine, ignition sequence, and output configuration selected? If you are 
not completely sure, contact the corresponding engine manufacturer. 

– Ensure that the ignition sequence of the engine or the wiring of the output wire harness is 
implemented correctly. 

– Is the wiring of all pickups compliant with the drawings given in this operating manual? 

– Are the distances of the pickups to trigger discs, projectiles, etc. correctly set? (See sections 
Defining Installation Locations, Installing Sensors, Setting Timing Correction Range and 
Trigger Disc on page 30). 

– Ensure that the data were transferred flawlessly to the controller. 

– Check whether the start/stop input is set to Firing active, or whether it works according to 
the control requirements of the superordinate control system. 

– Check whether the input contact for parameter settings A/B (Schedule A/B) functions and 
ensure that the correct settings (A or B) were selected for start-up. 

– Ensure that no gas is present in the inlet and exhaust systems before you start the engine. 

– Ensure that the gas valve is closed. 

– Perform the normal engine start-up process while the gas valve is closed (start only). 

– Connect a stroboscope to the first firing cylinder (cylinder #1) and check whether the timing 
point set on the ignition controller coincides with the actual timing point on the crankshaft. 
If the timing point does not coincide exactly, change it (see section Runtime Data on page 
87) until the optimum setting is reached. If the ignition does not fire, read the instructions in 
section Troubleshooting and Eliminating Errors on page 160. 

– Check all other cylinders for correct ignition. If they are not correct, stop the engine, and 
recheck wiring and ignition sequence for correctness. 

– Stop the starting process. If no problems occur, start the engine in accordance with the 
specifications of the engine manufacturer. 

 

10.2  Shut-Down 
The ignition controller is shut down by disconnecting it from the power supply. 
 

10.3  Behavior upon Activation (MIC Internal) 
Upon activation or restart, internal checks are performed first, then the system checks if an SD 
card is inserted. If no SD card is found, a validity check of the firmware currently installed is 
performed. If the check is completed successfully, the firmware is started. Otherwise, an error 
code (GPO3 flashes twice, and the error LED is on) is indicated, and the program is aborted. If an 
SD card is found, and if suitable firmware is stored on this card, the system first checks if a 
downgrade is to be implemented. With a downgrade, the firmware to be loaded to the device is 
older than the one currently installed. 

10 OPERATION
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For this purpose, hold down PB1 during start-up until PU C flashes. Otherwise, the firmware 
found is checked whether it is newer, i.e., has a higher version number than the one already 
installed. If newer firmware was found, or if a downgrade was initiated, the data integrity of the 
new firmware is ensured with a check sum (PU B flashes). After that, the firmware is installed on 
the MIC850 (PU A flashes). If the installation was successful, the newly installed firmware is then 
started. If the firmware detected is corrupted, the firmware already installed is checked for 
validity instead and started if successful. If the latter is also corrupted, an error code (GPO2 and 
GPO3 flash twice alternatingly, and the Error LED is on) is indicated, and the program is aborted. 
If the firmware found is not newer than the one already installed, and no downgrade was 
activated, the firmware already installed is checked for validity instead and started if successful. 
If the latter is corrupted, the system will attempt to install and start the firmware found on the 
SD card, anyway. If the latter is also corrupted, an error code (GPO2 and GPO3 flash twice 
alternatingly, and the Error LED is on) is indicated, and the program is aborted. 

 
 

10.4  Firmware Update 
Perform the following to prepare for the firmware update: 

1. Ensure a reliable power supply for the MIC850. 

2. Back up all files stored on the SD card (particularly important are the files: mic850.fwf, 
bl850.fwf and fw850.fwf).  

3. Copy the update file to the SD card and rename the file to mic850.fwf if necessary. 
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For the update, proceed as follows: 

1. Insert the SD card and start the device. 

▸ The update runs automatically and takes several minutes. 
Do not remove the SD card under any circumstances during this process! 

▸ The SD card is being initialized. The LED PU C flashes during this process. 

▸ The new firmware is checked for the correct hardware version, the proper device ID, a 
higher software version, and correct check sum. The LED PU B flashes during this 
process. 

▸ If everything is found to be correct, and the new firmware is a higher software version, it 
is adopted and started automatically. If the version number of the new firmware 
corresponds with the software version installed, or if it is lower, the new firmware is not 
installed. The LED PU A flashes during this process. 

▸ The new firmware is started. 

▸ The LED Status flashes. 

2. Remove the SD card once the update process has been completed. Otherwise, the check for 
a new firmware file will be performed every time the MIC850 is restarted. 

3. After a successful firmware update of the MIC850, check all configuration data. 

  
The following errors may occur during the firmware update: 

Error code Error Measure 

GPO 3 flashes twice,  
Error is on 

Installed firmware 
defective 

Reinstall firmware via SD card

GPO 2 and GPO 3 flash 
twice in alternating order, 
Error is on 

Installed firmware and 
firmware on SD card 
defective 

Copy new firmware to the SD card 
(repeat copying process if 
necessary) 

Error flashes up to 40 
times 

Internal checks failed Send device in if restart does not 
remedy the situation 

PU C flashes indefinitely Defective, wrongly 
formatted, or 
unreadable SD card 

Reformat SD card if applicable 
(FAT 16) 

  

 

Downgrade process 

The process for a downgrade is largely the same as the update process. 
Immediately after inserting the SD card, simply start the controller, then 
immediately press the pushbutton PB1. If the SD card contains an older 
version of the firmware file (mic850.fwf) than is currently installed, the 
downgrade process starts. 
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10.5  Operating Mode 

10.5.1 Operating Statuses 
On the MIC850, the automated status loop shown in the figure below is implemented. Central 
states during operation are the idle status Ready and the operating status Operational. In the 
following, we will explain the individual statuses and transitions. 

 

'Initialization' status 
The system is initially placed in the Initialization status in which the system is initialized. After 
successful initialization, the system transitions to the Ready status. 

'Ready' status 
In the Ready status, the system is ready to operate and waits for commands or events that 
trigger specific actions of the system. 
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'Configuration' status 
The system transitions from Ready to Configuration status if a configuration command was 
received via the USB interface. The device configuration can be changed only with this status. 
Normally, the configuration is completed by a command received via the USB interface. After the 
command is received, the MIC850 performs a plausibility check and accepts the new 
configuration only if this check finishes successfully. If the new configuration cannot be 
accepted, the configuration set before the Configuration status is restored. Pickup signals are 
not analyzed during the configuration process. 

'Self Test' status 
By issuing commands that can be transmitted via the USB interface or the HMI, the system can 
be switched between the statuses Self Test and Ready. The self test is aborted if pickup signals 
are detected. The system then transitions to the Operational Error status. 

'Operational' status 
When pickup signals are received, the system automatically switches from the Ready status to 
the Operational status. Once the engine stands still, the system switches back to the Ready 
status. In case of operational errors (e.g. pickup errors or overspeed), the system switches to the 
Operational Error status. While in the Operational status, there are sub-statuses, which depend 
on ignition release and speed and on whether the pickup signal analysis has just begun. 

'Synchronization' status  
The Synchronization status is the initial status within Operational. In this state, a machine cycle 
(camshaft signal) is expected first. After that, the system waits for the events that are being 
anticipated during a crankshaft rotation (ring gear signal, reset signal). When all events have 
been detected, the system switches, depending on the ignition release, to Firing Locked or Firing 
Active. 

'Wait For 0 RPM' status 
In this state, the system waits for the absence of the pickup signals and thus engine standstill. 
Once the engine is standing still, the system transitions to the Ready status. 

'Firing Locked' status 
If the pickup signals can be analyzed, but there is no ignition release, the system switches to the 
Firing Locked status. If the ignition release is issued, the system switches to the Firing Active 
status. If errors are detected in the pickup signals, the system switches to Synchronization or 
Operational Error, depending on the speed. 

'Firing Active' status 
With the Firing Active status, ignition is activated. In case of absence of the pickup signals, the 
system switches to Synchronization or Operational Error, depending on the speed. If the ignition 
release is retracted at a speed below the security speed, the system switches to Firing Locked, 
otherwise, it switches to Wait For 0 RPM. 
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'Operational Error' status 
In case of operational errors in the Operational status, the system switches to the Operational 
Error status. In this state, the device can only be monitored via the USB interface, but 
configuration, self test, or ignition functions are blocked. Only when no more pickup signals are 
detected can the error be acknowledged with a command via the USB interface or the HMI, and 
the system switches back to the Ready status. 

'System Error/No Error' status 
If a severe error occurs, after which the system can no longer be operated without restarting it, 
the system switches to the System Error status. Usually, the device can still be monitored via the 
USB interface or the HMI. All other statuses are sub-statuses of No Error. 

Transition T1 
The transition occurs after successful initialization of the firmware. If the firmware cannot be 
initialized, a critical error has occurred, which is being signaled with the LED on the cover panel. 
Also, the firmware execution is stopped. 

Transition T2 
The transition to Configuration is triggered with a command received via the USB interface. The 
transition back to Ready either occurs when a command to end the configuration is received via 
the USB interface, or if the connection to the PC is interrupted. 

Transition T3 
The transition to Self Test is triggered by a command received via the USB interface or from the 
HMI. The transition back to Ready is triggered with a command received via the USB interface or 
from the HMI. 

Transition T4 
If the system receives pickup signals, it transitions to Operational. Once the engine is standing 
still, the system transitions back to the Ready status. 

Transition T5 
If no pickup signals are registered, and the corresponding command is received from the USB 
interface or the HMI, the system transitions to Ready. 

Transition T6 
In case of operational errors (e.g. pickup errors or overspeed), the system switches to the 
Operational Error status. This immediately shuts down the ignition. 

Transition T7 
If a machine cycle and then all events that are being anticipated during a cycle (ring gear signal, 
reset signal) have been detected, and the ignition has been released, the system transitions to 
Firing Active. 
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Transition T8 
The transition to Firing Locked is implemented when the ignition release is retracted and no 
ignition has occurred above the security speed since the standstill of the machine. Also, the 
ignition is immediately shut down. The system transitions to Firing Active if the ignition release 
is issued. 

Transitions T9, T10 
In case of errors in the pickup signals and low speed, the system transitions to Synchronization. 

Transition T11 
If a machine cycle and then all events that are being anticipated during a cycle (ring gear signal, 
reset signal) have been detected, and the ignition has not been released, the system transitions 
to Firing Locked. 

Transition T12 
If the ignition release is retracted while the speed is higher than the security speed, the system 
transitions to the Wait For 0 RPM status. This shuts down the ignition. 

Transition T13 
The system transitions to the System Error status when an error is detected after the system can 
no longer be reliably operated (without restart). The ignition is immediately shut down, and the 
error cannot be acknowledged. 
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11.1  Possible Faults 
The MIC850 ignition controllers include several safety functions that can shut down the engine 
in case of fault: 

– Overspeed protection 

– External shut-down contact (Start/Stop) 

– Misfire detection (primary) 

– SCR error detection / internal failure of the high voltage supply 

– Shut-down in case of faulty pickup /signals 

– Alarms 

– Faulty voltage supply 

– External EMI signals 
 

11.2  Causes for Faults 

11.2.1 Overspeed 
The engine speed has exceeded the overspeed value. 

Potential causes: 

– Speed controller does not function properly 

– Fuel supply to engine is not optimum. 

– Faulty pickup signal 
 

11.2.2 SCR Error Detection 
An internal failure of the high voltage supply or a defective thyristor occurs. 

Potential cause: 

– Hardware defect on the MIC850. 
 

11.2.3 Misfire Detection (Primary) 
The primary misfire rate has exceeded the value configured in the alarm for primary misfiring. 

Potential causes: 

– Defect in the output wiring 

– Ignition coil defective 
 

11 FAULTS 
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11.2.4 Pickup Input Errors 
Faulty input signals from the pickups are detected. 

Potential causes: 

– Number of teeth on the flywheel does not coincide with the set number. 

– Interference in the wiring of the pickup. 

– Wiring of the pickup is not correct. 

– Distance of the pickup is not correct. 

– Contamination on the pickup. 
 

11.2.5 Low Power 
An error has occurred in the power supply to the MIC850. 

Potential causes: 

– The power supply is dimensioned too small. 

– The battery is worn out. 

– The wiring for the power supply is defective. 

– The wiring for the power supply is routed incorrectly. 

Indication of the error codes for Low Power Error via the LEDs upon activation: 

– if the PU A LED lights up yellow, and the PU B LED flashes yellow, this signifies that the 
voltage supply has dropped below 12 V. 

– if the Error LED flashes red, and PU A and PU C are on, this signifies that a critical error (Low 
Power Error) has occurred. 

 

11.2.6 Acknowledging Faults 
While the engine is shut down, you have the following options for acknowledging operating 
errors:  

– with Acknowledge operating error in the MICT 

– with Acknowledge in the Error Commands screen in the HMI (optional) 

– Disconnecting the supply voltage 

– Press pushbutton PB1 on the controller for several seconds. 
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11.3  Troubleshooting and Eliminating Errors 

11.3.1 Message and Error Overview 
The following errors and messages can be displayed in the MICT and HMI: 

Error code Description Causes 

no error No error  

trigger count Number of events per cycle 
counted does not correspond with 
set value. 

– Set value is wrong.

– Ring gear is defective. 

– Trigger disc runs out-of-center

– Faults in reset, index 
camshaft/crankshaft. 

– Reset is polarized incorrectly. 

– Pickup is dirty. 

– Pickup wiring 
is damaged. 

– Faulty connection to pickup 

trigger missing Number of counted events is 
smaller than expected number. 

– Reset is polarized incorrectly.

– Contaminations have 
occurred on the trigger disc 
during operation. 

– Trigger disc / ring gear was 
damaged during operation. 

– Pickup wiring 
is faulty. 

cycle signal missing Cycle signal was not detected in 
time. More events were counted 
than is expected per cycle. 

– Reset is polarized incorrectly.

– Faults on reset, index 
camshaft/crankshaft 
occurred. 

– Wiring to 
camshaft/crankshaft pickup 
is faulty. 

– Trigger signal was jammed. 

reset count Number of reset events is outside 
expected range. 

NOTE
Only for 4-stroke engines: 
Fault coupled with reset signal. 
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Error code Description Causes 

trigger period Current event period is outside 
the valid range with reference to 
the previous event period. 

– Fault coupled with trigger 
signal 

– The wiring to the trigger 
pickup is faulty. 

– The trigger pickup is dirty. 

– Trigger disc / ring gear was 
damaged during operation. 

pickup pre-
processor  

Pre-processor pickup causing 
errors. 

NOTE
N+1 / N-1 trigger discs 

overspeed Overspeed. – Overspeed

– Fault coupled with trigger 
signal 

missing output 
board  

Output board could not be 
detected. 

– An output board is defective.

SCR or HV error Thyristor error occurred / 
Problems with primary high 
voltage generator. 

– Thyristor is faulty.

– Problem occurred with high 
voltage 
generator. 
 
NOTE 
Send the device to 
MOTORTECH. 

– Short circuit on 1 to 1 output. 

misfire rate 
 

Misfire rate exceeded. – The misfire rate was 
exceeded. 

low power or shut-
off 

Voltage too low. – Deactivation of the device.

– Problems with the 24 V power 
supply. 

general General error. NOTE
Send the device to MOTORTECH. 

alarm shutdown  The ignition is shut down due to 
an alarm. 

– The limit set for an alarm 
resulting in engine shut-down 
was exceeded or not reached. 
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Error code Description Causes 

reset by watchdog The device was restarted by the 
watchdog. 

NOTE
Consult MOTORTECH service 
department. 

temperature The max. permissible device 
temperature was exceeded. 

– ambient temperature too high

pickup signals in 
self test 

The self test was aborted because 
pickup signals were detected. 

– Fault coupled with pickup
signal. 

– Engine was started 

  
 

11.3.2 Running a Self Test 
You can run the self test via the MICT or the HMI to check the sequence of the wiring and the 
connection between the ignition controller outputs and the spark plugs. Start the self test as 
follows: 

– MICT: Device -> Send commands -> Start self test 

– HMI: ->Main Menu: Commands -> Commands: Self Test -> Self Test 

  

 

Operational Safety 

If you use the self test function, it is compulsory to shut off the gas feed line 
and all cylinders are purged of fuel. Non-compliance can result in damage 
to equipment or injury to persons. 

  
 

11.3.3 Customer Service Information 
You can reach our customer service during business hours by phone, fax, or e-mail at: 

Tel. +49 5141 9399 0 

Fax +49 5141 9399 99 

E-mail servicemail@motortech.de 
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11.3.4 Returning Equipment for Repair / Inspection 
Enclose an insert containing the following information when returning the equipment for repair 
and inspection: 

– Name of operating company 

– Name and location at which the equipment is installed 

– Name and phone number of a contact person 

– Engine type 

– Part and serial numbers of the device 

– Description of the defect/error 

– Instructions concerning the desired type of repair/inspection 

Providing this information will ensure the speedy and smooth processing of your repair order. 

Send the equipment to one of the two addresses below or to the nearest MOTORTECH 
representative: 

  
MOTORTECH GmbH 
Hogrevestrasse 21-23 
29223 Celle 

Germany 

Tel. +49 51 41 - 93 99 0 
Fax +49 51 41 - 93 99 98 

www.motortech.de 
motortech@motortech.de 

MOTORTECH Americas
1400 Dealers Avenue 
New Orleans. LA 70123 

USA 

Tel. +1 504 355 4212 
Fax +1 504 355 4217 

www.motortechamericas.com 
info@motortechamericas.com 

  
 

11.3.5 Instructions for Packaging the Equipment 
For return shipment, equipment should be packaged as follows: 

– Use packaging material that does not damage the equipment surfaces. 

– Wrap the equipment with sturdy materials and stabilize it inside the packaging. 

– Use sturdy adhesive film to seal the packaging. 
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12.1  Maintenance Instruction 
Please follow the following maintenance instructions: 

– Do not use caustic liquids or steam cleaners for cleaning the optional display. Do not use 
blunt force on the display during cleaning. 

– To control the energy levels based on the operating hours of the spark plugs, you must reset 
the operating hours counter for the spark plugs each time you replace the spark plugs. 

– Clean the passive pickups at regular intervals. 

– Check the ignition wires at regular intervals. 

– Replace the pickups at regular intervals if operating them under elevated temperature 
conditions (> 90 °C / > 194 °F). 

– Regularly inspect all wires of the ignition system for damage and replace the wires as 
needed. 

– Check all plug-in connections for proper condition. 

– Service the spark plugs as per the instructions of the spark plug and engine manufacturers. 
 

12.2  Spare Parts and Accessories 
For spare parts and accessories for MIC850 ignition systems, please refer to our current product 
guide, which is available to you for download on the Internet at www.motortech.de. 
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